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Abstract

Single-hole orifices are often applied noise sources in cooling water pipes. These components disturb
internal fluid locally which subsequently results in pipe wall vibrations elsewhere in the system. In the
extreme ultraviolet machines ASML produces, these vibrations lead to end-product inaccuracies. To model
the expected flow-induced vibrations with the tool PlaNet3D, an accurate description of the source term is
required. This study determines this hard-to-measure source term using practical Large Eddy Simulations
(LES).

Previous studies have shown that acoustic noise is generated via the action of vortex stretching relative
to the body, wall separation and vortex shedding. For low Mach number flows, these noise generating
mechanisms are represented as an in time fluctuating force acting from the orifice to the fluid. Incom-
pressible LES are performed using a recycling plane method at the inlet. This proposed method is easy to
implement and is applicable to different geometries. Results of LES on computational grids with different
grid sizes are compared with experiments and Direct Numerical Simulations (DNS). Refining the grid till
sizes equal to the Taylor microscales, a good match with DNS pipe flow profiles is obtained for the first and
second order flow statistics. Additionally, the power spectral density (PSD) of wall pressure fluctuations
in a straight pipe agrees with experimental data.

After the straight pipe flow is properly resolved, an orifice is added to the straight pipes. The simulated
pressure drops generated by the orifice are according to values found in literature. Besides, the pressure
drop fluctuations are found to match with force fluctuations divided by the pipe area indicating a conser-
vation of momentum. A comparison of a DNS one-dimensional energy spectrum with LES on the finest
grid shows a good match in the inertial subrange. This indicates properly resolved turbulent scales. Ad-
ditionally, the resolution in the jet-wake region is found acceptable based on the turbulent viscosity ratio.
The PSD slope of wall pressure fluctuation in the jet-wake region matches with theoretical power laws
and experimental data. However, the pressure fluctuations in that region are overpredicted by LES. The
PSD of wall pressure fluctuations in the orifice and upstream of the orifice show a similar shape compared
to the simulated force spectra acting on the fluid. The spectra consist of distinct peaks at frequencies
which are different for each used computational grid. A peak might be due to vortex shedding, which is
found to occur at a Strouhal number of roughly 0.4. But, possibly this peak is nonphysical arising from
numerical inaccuracies and thus requires further investigation. Nonetheless, the slope of the force spectrum
obtained with LES on the finest considered grid is the same as found in literature and is therefore found
accurate. The simulations are performed within a week so a practical LES setup is proposed to accurately
determine the source term. In following studies it is recommended to simulate different geometries and
flow conditions.
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Chapter 1

Introduction

ASML is currently developing and improving her new Extreme UltraViolet (EUV) lithography machines.
These machines are able to manufacture computer chips with structures as small as 13 nm. A general goal
of ASML is to decrease the structure size. A smaller structure size decreases the travelling distance of an
electrical signal. If this distance decreases, the performance of the computer chip increases. The heart of a
EUV machine in which these chips are manufacture is depicted in Figure 1.1. Ultraviolet light is emitted
by a source and is afterwards going through an illuminator to the reticle. The reticle contains the blue
print of the structure and adds that to the light. Light is then entering the Projection Object Box (POB).
In the POB mirrors reflect light to the wafer where the printing process starts.

Figure 1.1: EUV deployed to write structures on a wafer. The source emits light on a reticle containing a
blue print. This image is then reflected via mirrors to the wafer where the structure is printed on a silicon
plate.

Mirrors in the POB are hanging in a force frame. The location of the force frame is measured with a
sensor frame which surrounds the force frame. Additionally, the location of the wafer stage is measured.
This wafer stage carries and moves the wafer. To obtain small structure sizes on the computer chip, all
frames should be perfectly aligned. However, this is a very difficult task as the frames are in the vicinity
of vast heat sources. To guarantee alignment of the frames, thermal expansion of components should be
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avoided. Therefore the temperature of the frames are controlled up to a millikelvin-level. This temperature
control is achieved using a cooling water system. However, the usage of a cooling water system comes
with additional vibrations due to water disturbance in the cooling pipes. This problem is the topic of this
thesis.

These vibrations of the cooling system, referred to as Flow-Induced Vibrations (FIV), are caused by a
disturbance of internal fluid (R. D. Blevins (2001)). In a wide range of industries this phenomenon causes
severe problems. Examples are found in nuclear industries in which this leads to failure of structures
(R. Blevins (1979); Bush (1992)). In the high precision machines of ASML, however, flow-induced vibra-
tions simply affect the intended tight tolerances negatively. The inaccuracies by FIV will shift of the line
of sight in the order of picometers, which should be avoided. Whereas FIV was relatively unimportant
a decade ago, it is now a hot topic adhering ASML’s slogan: ‘Changing the world, one nanometer at a
time’.

Fluid disturbances, in the form of acoustic noise, cause water cooling pipe wall excitations. Acoustic noise
is propagating as pressure waves with the speed of sound in the form of one-dimensional plane modes
and higher order modes. These modes are able to travel long distances and interfere with pipe corners
which in turn excite a motion of the system (R. D. Blevins (2001)), indicated by red arrows in Figure 1.2.
This fluid-structure interaction phenomenon is initiated by components that disturb the flow, depicted
in Figure 1.2 as the brown blocks with green arrows. Water is provided by a cabinet and is distributed
through the system by Liquid Cooling Water (LCW) lines. As pressure waves tend to propagate far up-
and downstream, a coupling exists between the noisy ambient and the vacuum environment in the machine,
see Figure 1.2. This raises the problem that generated acoustic noise in the ambient region also affects the
sensitive vacuum region, as well as directly generated disturbances in that region.

Figure 1.2: Water cooling system containing a sensitive and nonsensitive region. The brown parts are
disturbing components generating a flow disturbance indicated by a green arrow. Resulting excitations of
the piping system are indicated by a red arrow.

Water cooling circuits in ASML’s machines consist various types of these flow disturbing components
which cause flow disturbances (green arrows), illustrated as brown blocks in Figure 1.2. An example of a
FIV-active applied component is a single-hole orifice (Agarwal (1994b)). Orifices are deployed to generate
a significant pressure drop (Cairns, Whitson, Strachan and Wheel (1970)) and are specifically used for
flow balancing, i.e. to control mass flow rates. As every cooling branch in the cooling system has its own
resistance, the orifices are essential to guarantee the prescribed mass flow rate and can therefore not be
removed. Other examples of FIV-active components are changes in flow area and sharp bends as mentioned
by Bull and Norton (1981), which are equally important.

These disturbing components are known to generate significant noise locally, referred to as turbulence
or pseudo noise (Moussou (2006)). Generally, direct effects of these hydrodynamic pressure fluctuations
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damp out after about six diameters (Anantharaman (2014); Anantharaman, Waterson, Nakiboglu, Persin
and van Oudheusden (2016); Moussou (2006); Qing, Jinghui, Yushan, Haijun and Quan (2006); Tao et
al. (2017)), and are therefore of no problem in non-sensitive parts of the machine. In sensitive parts the
cooling pipe is designed smooth such that no strong hydrodynamic fluctuations cause pipe wall vibrations.
However, besides local hydrodynamic pressure fluctuations, other types of noise exist (Hirschberg (2007)).
A phenomenon possibly playing a large role in total noise generation is cavitation (Ebrahimi et al. (2017);
Testud, Moussou, Hirschberg and Aurégan (2007)). It is assumed that ASML machines are designed such
that cavitation does not occur and is therefore left out of the analysis in this thesis. Additionally, acoustic
noise contributes to the total noise level which is dominant in low Mach number regimes far from sources
according to Michalke (1989) and Rienstra and Hirschberg (2001). Thus, despite designing for smooth
non-disturbing water cooling pipes in sensitive regions, noise should be expected from the noisy machine
part. Certain levels of noise from a cooling water system is inevitable. In line with this, Moussou (2006)
mentioned that a far field coupling exists between the generated pressure and a structure.

At ASML every part of the machines has a budget to which level it may add an inaccuracy to the system.
The budget of FIV is measured via pipe wall vibrations. These pipe wall vibrations are computed with
PlaNet3D. This tool translates the disturbance by a FIV-active component to pipe wall accelerations. The
principles of these tools are described later, but it should be mentioned that the input is a description of
the source term generating the noise. First of all this requires a proper understanding of the mechanism
generating the noise. Secondly, this source term should be provided. However, as the equations governing
flow are non-linear, it is difficult to accurately predict the source term under conditions they do produce
sound according to Hirschberg (2007). Additionally, only the resulting acoustic noise can be measured
rather than the source term itself. Despite this, a determination of source term characteristics is possible
using a scaling law based on mean flow parameters (Moussou (2006)), but is rather general.

As of the above, it is not within the possibilities of ASML to come up with an accurate description of
the source term. At the moment this is done by simply measuring one-sided pressure fluctuations. But,
this method is assumed inaccurate. Because of that there is a need to have a proper understanding and
description of the source term that disturbs fluid in the water cooling system of ASML machines. The
work in this thesis is to fulfill this need. An encouraging method do so is using Computational Fluid
Dynamics (CFD) software. Using a transient solver like Large Eddy Simulation (LES) should give the
option to extract this fluctuating source term. A commercial CFD package STAR-CCM+ is available to
carry this out. This method, however, can be very costly in terms of computational time and therefore a
practical approach is adopted to obtain quick answers. The title of the thesis is therefore: ‘Determination
of the source term disturbing bounded flow using practical Large Eddy Simulations’.

1.1 Research questions

Summarizing; in the current approach of ASML, the modelling tool PlaNet3D is used to generate pressure
fluctuations with which it models forces on structures. With these forces, pipe wall accelerations are
calculated to subsequently come up with an estimate of the error of the line of sight of the printing process
onto the wafer. Accurate and real pressure signals, though, require an accurately described source terms.
In order to provide this, the following questions raise

• What mechanisms generate acoustic noise in the presence of an orifice in turbulent water pipe flow?

• Is there a significant single source term accountable for generating the acoustic noise? If so, what is
the nature of the source term that induces acoustic noise? Additionally, if this is the case, why are
measurements not suitable for determining this disturbing source?

Answers to these questions are crucial before starting analyzing the flow behavior with a commercial CFD
package. Concerning the simulations specifically, the following research questions are to be answered

• Is LES a promising simulation tool for determining the full behavior of the source term?

• Is it possible to create a general setup to determine the disturbing source term in different bounded
flow geometries?

• Can accurate simulation results be obtained for engineering purposes within a week using practical
LES?

3



CHAPTER 1. INTRODUCTION

These questions need to be answered to get insight in the usability of LES in future design processes. All
in all, the above itemized research questions are to be answered in order to solve the problem ASML faces
concerning flow-induced vibrations in the process of machine design improvement.

1.2 Research approach

With the research questions in mind, a research approach is proposed to solve the described problem. The
research questions give direction in this and partly determine the approach. The outline of the thesis is
illustrated in Figure 1.3. In Chapter 2 the relevant literature will be reviewed. Topics are treated which
are related to the research questions. Answers to the first research questions are already given in the
conclusion of this chapter. Chapter 3 will consist of a summary of experimental results obtained mainly
at ASML and the TU/e. This will provide a better understanding of the problem and later on this data
will be used for comparison with simulation results.

Chapter 4 describes the numerical approach to determine the source term. The simulation setup choices
and a description of the theory behind the simulations will be elaborated on. In chapter 5 and 6 simulation
results will be given. Chapter 5 is focusing on the flow through a straight pipe, mainly to distinguish
between and understand different simulations setup results. In chapter 6 LES results of a straight pipe
including an orifice will be discussed. To obtain these results, design choices are based on the results of
the straight pipe analysis. In the last two chapters, conclusions are drawn and the scope for future work
is proposed.

In the appendices different topics are described: the first appendix gives a detailed step approach to derive
an analytical solution for the coupling of pressure and source fluctuations, the second appendix gives a
summary to setup a simulation as used in this thesis, the third appendix summarizes RANS simulations
performed to serve as background for the numerical approach for transient simulations, the fourth appendix
gives illustrations of the used computational grids, and the fifth appendix provides additional results of
the straight pipe analysis.

Chapter 1

Introduction

Chapter 2

Review of Literature

Chapter 3

Review of Experimental Data

Chapter 4

Numerical Approach

Chapter 5

Results of Straight Pipe
Chapter 6

Results of Orifice

Chapter 7

Conclusions &

Recommendations

Appendices

References

Figure 1.3: The outline of the thesis.
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Chapter 2

Review of Literature

In this chapter a review of the literature is given. This information is required to answer the first two
research questions. First the governing equations are given. Then a description of the tool PlaNet3D is
provided. This clarifies the need for a source term description. Afterwards all the information concerning
flow induced noise is treated. Then the flow through orifices is elaborated on investigating the possible
mechanisms generating noise. Thereafter, the nature of possible sources are studied and it is determined
which source is dominant in this problem. A possible exact solution to couple pressure and source fluctu-
ations is investigated next. Afterwards, a review of experimental work done outside of ASML regarding
measuring flow noise is provided. Finally, a list of CFD studies on orifice flow is given.

2.1 Governing equations

In this work flow is assumed incompressible. The Navier-Stokes equations describe the motion of this
flow. For incompressible flow, these governing equations are given in conservative form as (J. Anderson
(2016))

∂ui
∂xi

= 0 (2.1)

ρ
∂ui
∂t

+ ρ
∂ (uiuj)

∂xj
= − ∂p

∂xi
+ µ

∂2ui
∂xj∂xj

+ Fi (2.2)

These are respectively the conservation equations of mass and momentum. Here ρ is the density, ui is
the velocity component in i-direction, p is the static pressure and µ is the dynamic viscosity. The index
notation is such that i = [1, 2, 3] representing the radial, tangential and axial component respectively. In
the momentum equation, see Equation 2.2, Fi represents internal/external forces acting on fluid per unit
volume. Dividing the momentum equation by the density and rewriting the viscous term results in

∂ui
∂t

+
∂ (uiuj)

∂xj
= −1

ρ

∂p

∂xi
+

∂

∂xj

[
ν

(
∂ui
∂xj

+
∂uj
∂xi

)]
+
Fi
ρ

(2.3)

Here, ν, is the kinematic viscosity. In square brackets now the viscous stress tensor for incompressible
fluids, τij , arises. Note that these viscous stresses are typically low for highly turbulent flows. In this
momentum equation, the left hand side represents the temporal and spatial change in fluid momentum.
When averaging the convective term ρuiuj in time the turbulent stresses appear.

2.2 Pipe excitation prediction tools

An often used tool to predict pipe wall acceleration is the inhouse tool PlaNet3D (Kemper (2014)). It is
based on a lumped-mass representation of a fluid network. It enables to model fluid-structure interactions
because the geometry and fluid hydraulics are coupled. Using this tool, it is assumed that pressure waves
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can be described by the one-dimensional acoustic wave equation. Under some assumptions this is true
(Kao, Graham, Knight and Pericleous (2007)). The one-dimensional wave equation is given by

1

c2
∂2p′

∂t2
− ∂2p′

∂x2
=
∂F ′

∂x
(2.4)

Here, p′ is the fluctuating static pressure and c is the speed of sound in water. Comparing the mass and
momentum conservation equations with those for a mass-spring system, these are analogous and therefore
the fluid can be regarded as a lumped mass-spring system. Such a system is depicted in Figure 2.1 and is
governed by

mẍ+ (C1 + C2)x = Fw→f (2.5)

The force Fw→f , here presented as a force from wall to fluid, is internally induced by the flow. The
mechanisms that bring about this force will be studied later on. In Equation 2.5 the stiffness C is analogous
to KAp/L for flow. L is the duct element length, K is the fluid bulk modulus, and Ap is the cross sectional
pipe area. The input parameter required is the force of the disturbance part on the fluid. With that the
pressure waves are initiated and the resultant forces on parts of the network are modelled.

Figure 2.1: Lumped mass-spring system used in PlaNet3D to represent acoustic pressure waves in fluid
flow.

2.3 Turbulence

To understand the phenomenon generating noise, and to understand length and time scales in upcoming
simulations, a firm understanding of turbulence is needed. Turbulence is a phenomenon in which chaotic
motions with excessive kinetic energy overcome the damping effect of the viscosity. It is characterized
by changes in pressure and velocity and plays a key role in the generation of noise and pressure drops.
Turbulent flows consist of eddies, or vortices, with a spectrum of length and time scales. In such flows
larger eddies are unstable and break up and with that transfer their energy to smaller eddies driven by
vortex stretching (Richardson (1922)). This is summarized in the energy cascade (Richardson-Kolmogorov
cascade) and continues until Reynolds numbers are small enough so that the turbulent kinetic energy
(TKE), k, is dissipated into heat through the action of molecular viscosity. TKE consists of the fluid
shear stresses for i = j, which are the variances of the velocity components in axial, radial and tangential
direction, defined as

k =
1

2

∑(
u′i

2
)

(2.6)

The axial direction is defined in thesis as the z-direction. The components are determined by calculating
the mean fluctuation of a time signal squared. Note that this is only legit in the directions i = j. To
determine the turbulent shear stresses (i 6= j), u′iu

′
j , Reynolds’ decomposition is used which is φ = φ+ φ′.

φ̄ indicates the mean of a variable, and φ′ indicates the fluctuations of a variable. With this, all turbulent
stresses are calculated as

u′iu
′
j = uiuj − ūiūj (2.7)

From Cartesian coordinates, the radial and tangential velocity components are defined as

ur = ux cos(θ) + uy sin(θ) , ut = −ux sin(θ) + uy cos(θ) (2.8)

Here, θ is the angle between the radial and tangential component in radian. In the energy spectrum,
scales containing most turbulence kinetic energy are characterized by the large energy-containing eddies,
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`0, given as

`0 =
k

3
2

ε
(2.9)

Here, ε is the turbulence dissipation rate (TDR) which is the rate at which TKE is dissipated into thermal
energy. Most of the energy is present in a turbulent length scale (TLS) range of 1

6`0 < ` < 6`0. This
range is referred to as the energy-containing range, depicted in Figure 2.2a. In this range typically energy
is injected to the flow. Note that in Figure 2.2a, L is the largest flow scale.

(a)

(b)

Figure 2.2: a: Characteristic eddy sizes in turbulent flow (Pope (2001)). b: Energy cascade.

The smallest scales in turbulent flows are characterized by Kolmogorov (1941)

η =

(
ν3

ε

)1/4

(2.10)

At this smallest scale, the Kolmogorov length scale, η, TKE of fluid flow is dissipated into heat. Only these
dissipative eddies experience significant effect of molecular viscosity. Eddies with a length scale of ` < 60 η
do cover the dissipation range, also illustrated in Figure 2.2. Last, a range exists in between the range at
which most of the energy is present and the range at which most energy is dissipated. Motions of these
turbulent structures are typically dominated by inertial effects. In this range, there is a continuous cascade
of energy from larger to smaller turbulent scales. Energy is only transferred in this range as no energy is
produced nor dissipated. In this range, a length scale exists at which turbulent structures get affected by
viscous effects defined by Taylor. These Taylor microscales, λ, are given as (Pope (2001))

λ =

√
15
ν

ε
u′i ≈

√
10ν

k

ε
(2.11)

As already visible in Figure 2.2b, this length scale is important in CFD simulations. Along with all
described length scales, time scales are important characterizing turbulent flow. Kolmogorov’s time scale
represents the eddy-turnover time of the very smallest scales as

tη =
ν

ε

1
2

(2.12)

For larger eddies, the eddy-turnover time is defined as

t` =
k

ε
(2.13)

t` is a time scale for an eddy to traverse the inertial range. It is important to note that the magnitude of
separation between both length and time scales increases as the Reynolds number increases respectively
as

η

`0
∼ Re−3/4L ,

tη
t`
∼ Re−1/2L (2.14)

ReL is based on the bulk velocity, Ub, and largest flow scale.
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2.4 Orifice flow

Often applied FIV-active components are orifices. In Figure 2.3, the mean flow through a single-hole orifice
plate is depicted. By conservation of mass, water flowing through the orifice accelerates to compensate for
the decrease in area resulting in the formation of a high velocity jet downstream of the orifice. Whereas
the static pressure upstream of the orifice is high, it decreases just downstream of the orifice. According
to Bernoulli’s principle, the static pressure reaches its minimum at the vena-contracta which is where the
jet velocity is highest. Further downstream, the static pressure increases again as a result of a decrease
in flow velocity. However, a permanent total pressure loss over the orifice is achieved being a function of
geometry and flow specifications as studied by Anantharaman (2014).

Figure 2.3: Pipe flow through a single-hole orifice, generating a pressure drop.

The maximum pressure drop over an orifice is given by (Bird, Stewart, Lightfoot & Klingenberg, 2015)

∆pmax =
1

C2
d

1

2
ρU2

b

(
β−4 − 1

)
(2.15)

Here, Cd is the discharge coefficient and β is the orifice hole to pipe diameter ratio. The permanent
pressure drop and maximal pressure drop can be related with the empirical relation

∆pperm
∆pmax

= 1− β2 (2.16)

Note that when the discharge coefficient is unity, Bernoulli’s relation for static and dynamic pressure
holds. The discharge coefficient, however, includes the effect of a direct pressure loss arising from zones of
turbulent separated flow. To understand why a pressure drop is generated, conservation of energy has to
be studied as done by Pope (2001) for jets. For incompressible flow through orifices at low Mach numbers,
the decrease in mechanical power dissipation, or energy dissipation rate is given as

ε = Q∆pperm = Q∆(p+
1

2
ρu2) = ε̄+ εk (2.17)

where Q is the volume flow rate. The total decrease in mechanical energy should be equal to the increase of
internal energy and turbulent kinetic energy according to Kundu, Dowling, Tryggvason and Cohen (2015).
For a fixed control volume it should therefore hold that

−
∫∫

∂V

ρui

(
p

ρ
+
u2

2

)
dS =

∫∫
∂V

ρui(e+ k)dS (2.18)

In here, e, is the internal energy. Both mechanisms at the right-hand side of Equation 2.18 are contributing
to the resulting total pressure loss. The mechanisms of increase in TKE and internal energy are depicted in
Figure 2.4. Here, D denotes the energy dissipation rate. Note that TKE is first produced and afterwards
dissipated as already seen in Figure 2.2b. Production and dissipation of turbulence kinetic energy is
producing the FIV disturbances.
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Figure 2.4: Mechanisms dissipating mechanical energy responsible for the permanent total pressure loss.

Considering the kinetic energy E of a fluid flow. According to Pope (2001), its mean can be decomposed
into two parts as

E(xi, t) =
1

2
ūiūi +

1

2
ui′ui′ (2.19)

The first term is the kinetic energy of the mean flow whereas the second is the turbulence kinetic energy
which followed from the Reynolds decomposition. Evolution of E based on the Navier-Stokes equations
helps rewriting the components of Equation 2.19 respectively as (see Pope (2001))

D̄Ē

D̄t
+
∂T̄i
∂xj

= −P − ε̄ (2.20)

D̄k

D̄t
+
∂Ti
′

∂xj
= P − εk (2.21)

Here, T is the flux of energy, see Pope (2001). P is the source producing turbulent kinetic energy and is
called production and is defined as

P ≡ −u′iu′j
∂ui
∂xj

(2.22)

Sink ε dissipates kinetic energy as ε̄ ≡ 2νS̄ijS̄ij and turbulence kinetic energy as εk ≡ 2νsijsij with mean
and fluctuating rates of strain S̄ij and sij defined in general as

Sij =
1

2

(
∂ui
∂xj

+
∂uj
∂xi

)
(2.23)

So the first mechanism transfers kinetic energy directly into internal energy by ε̄ in Equation 2.20, indicated
by D̄ in Figure 2.4. The second mechanism removes kinetic energy from the mean flow which by mean
velocity gradients, see Equation 2.20, is transferred to the fluctuating velocity field in Equation 2.21 by
production, indicated by Pk in Figure 2.4. Consequently, this formed turbulent kinetic energy working
against fluctuating stresses results its transformation into internal energy, indicated by Dk in Figure 2.4.
Generally, a permanent total pressure loss in static pressure arises from the large mean and fluctuating
velocity gradient between the jet and recirculation zones causing dissipation of energy (Van der Zande
(2000)). Both are contributing to the total shear stress in fluid flow defined as

τtotal = τv + τT = µ

(
∂ui
∂xj

+
∂uj
∂xi

)
− ρu′iu′j (2.24)

As for the viscous shear stress affected by molecular viscosity, an eddy viscosity exists relating the turbulent
shear stress to the velocity gradient, as will be seen later.

2.5 Flow noise

Flow noise can be described as deviations from a mean fluid state: φ′ = φ − φ̄. An example is given by
hydrodynamic fluctuations, occurring in the jet-wake region (Anantharaman (2014)). This is also referred
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to as pseudo noise as this type of noise does not radiate in fluids in the form of acoustic waves. This
type of noise arises from turbulent separation followed by flow reattachment to the wall. This type is not
considered as this cannot generate pipe accelerations elsewhere in the system. The sound focused on in
this thesis is able to radiate and propagates in the form of acoustic waves through fluids with the speed of
sound. These waves propagate linearly in stationary and homogeneous fluids. The momentum equation
can be linearized, neglecting second order terms, as

∂ (ρui)

∂t
= − ∂p

∂xi
(2.25)

For flow speeds much smaller than the speed of sound in water, flow can be assumed to be incompressible
(Wagner, Hüttl and Sagaut (2007)). The speed of sound for fluid is given (via the bulk modulus) as

c =

√
dp

dρ
(2.26)

Using this, and combining the mass conservation equation (Equation 2.1) and the linearized momentum
equation (Equation 2.25) results in the homogeneous wave equation

∂2ρ′

∂t2
− c2 ∂

2ρ′

∂x2i
= 0 (2.27)

In Equation 2.27, the density can be interchanged with the acoustic pressure fluctuations p′. Note that
combining the mass and momentum equation is required to couple the source term with the pressure
fluctuations. The one-dimensional solution to this homogeneous wave equation reads

p′(z, t) = g(z − ct) + h(z + ct) (2.28)

Here, g and h represent waves propagating in the positive and negative axial direction. In those plane
waves, the pressure is typically constant. One-dimensional travelling waves exist when the wavelength of
the waves is much larger than the characteristic length according to Rienstra and Hirschberg (2001)

f <
c

2Dp
(2.29)

In a frequency range up until almost f = 105 Hz this is the case, which is in the range of interest for
ASML. This, however, introduces the problem that energy content can be transported for long distances
without decreasing in level significantly. This means that flow disturbances at non-sensitive locations can
lead to FIV at sensitive locations.

2.6 Noise generation

In orifices plates, acoustics can be divided into two parts. On the one hand orifices scatter sound passively.
On the other hand orifices generate sound actively, for example generating a standing wave. In this
thesis only the active property is studied. This active generation of sound can arise from several different
mechanisms. These mechanisms can be categorized in three noise types; monopole noise, dipole noise, and
quadrupole noise, see Figure 2.5. In confined flow with impermeable walls, however, monopole noise, see
Figure 2.5a, is not generated directly or indirectly by orifices and is left out of scope in this thesis. This
type of noise namely arises from fluctuating volume flow which is not the case without mass injection or
leakage. Note that this type of noise may be introduced by e.g. pump behavior in experimental setups
(Moussou, Lafon, Potapov, Paulhiac and Tijsseling (2004)).

2.6.1 Quadrupole noise

Quadrupole noise is generated by turbulent fluctuations in free fields or by varying tangential shear stresses
at surfaces (Alenius (2012)). In the separation zone downstream of the orifice, an adverse pressure gradient
forms whenever the static pressure increases in downstream direction. This results in fluid reversal close
to the wall (Anantharaman et al. (2016); Bull and Agarwal (1983)), referred to as reversed flow, which

10



CHAPTER 2. REVIEW OF LITERATURE

is the reason for flow separation. Later on the flow reattaches to the wall at the reattachment point.
This point is experimentally found to be variable in time by Bull and Agarwal (1983), indicating that
the pressure gradient pattern is not steady and thus the tangential shear stress will vary. Varying wall
shear stresses are experimentally studied for back-facing step flow by Spazzini, Iuso, Onorato, Zurlo and
Di Cicca (2001). This involves vortex formation and breakdown attributed to the flapping motion. These
vortices are responsible for mixing and intensive fluid behavior. W. K. Blake (1986) explains noise to
be generated whenever vortex lines are stretched or accelerated relative to the acoustic medium. The
existence of vortex shedding producing sound occurs in particular for orifices with sharp or downstream
rounded edges (A. Anderson (1955); Rienstra and Hirschberg (2001)).

Lighthill (1952) initiated a theory describing the acoustic quadrupoles radiating sound in fluid flow.
Without simplifying the conversation equation of mass and momentum, a non-homogeneous wave equation
is presented

∂2ρ

∂t2
− c2 ∂

2ρ

∂x2i
=

∂2Tij
∂xi∂xj

(2.30)

The additional source term at the right hand side of Equation 2.30, Tij , is the Lighthill turbulent stress
tensor defined as

Tij = ρuiuj − τij +
(
p− c2ρ

)
δij (2.31)

Physically this means that sound produced by fluid flow can be compared with a medium at rest subjected
to externally applied fluctuating stresses. In this free-field fluctuating stresses thus behave as sound
generating quadrupoles. Lighthill (1952) has shown that for sufficiently low Mach numbers this stress
tensor term reduces to

Tij ≈ ρuiuj +O(M2) (2.32)

Here, M is the Mach number defined as the water velocity over the speed of sound. The viscous stress
term (deviatoric stress) is neglected because of the dominance of inertial effects and the pressure stress
term (volumetric stress) is neglected because of low density fluctuations. This is legit in the treated case.

(a) Monopole. (b) Dipole. (c) Quadrupole.

Figure 2.5: The sound fields produced by the different source terms.

2.6.2 Dipole noise

Whereas quadrupole noise arises from free field turbulence, dipole noise is generated when an fluctuating
external force is applied on a medium, already clarified by Lighthill (1952). Obviously, in the vicinity
of bodies this is likely the case (W. K. Blake (1986); Junger and Feit (1986)). One should think of
mechanisms as vortices hitting surfaces, unsteady vortex shedding, and unsteady flow separation that
cause these fluctuating forces on surfaces. Try this by comparing blowing in free field and disturbing the
flow with an object. Dipole noise is introduced and a higher acoustic level is noticed.

Distribution of turbulent flow over a surface results in normally oriented dipole sources to that surface.
These dipole sources are distributed in axial direction over the orifice surface as the orifice is perpendicular
to the flow. The strength of this total source depends on the level of unsteady aerodynamic loading (Tao
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et al. (2017)). Physically, the noise generating source may be regarded as a piston moving back and forth
in a pipe. Alenius (2014) concluded that for compressible pipe flow with orifice, the main sound generating
mechanism is fluctuating surface forces at orifice sides caused by strong passing vortex rings. Similarly,
W. K. Blake (1986) describes dipole sound to be produced when vortex lines are stretched or accelerated
relative to a body in the flow, as forces are exerted on the body-fluid interface.

Curle (1955) continued on Lighthill’s work including the influence of solid boundaries upon the sound field.
Incorporating the external force, as shown in Equation 2.2, an additional source term appears

∂2ρ

∂t2
− c2 ∂

2ρ

∂x2i
=

∂2Tij
∂xi∂xj

− ∂Fi
∂xi

(2.33)

Besides including the additional source term at the right hand side of the wave equation, Curle (1955)
explained that the contribution of sound generation by dipoles sources is most relevant for flows with low
Mach number. It is thus more efficient in radiating sound compared to quadrupole type sources. This is
especially true in the far field which is of interest in this thesis.

2.6.3 Dominant source term

Two distinct sources may thus be regarded deriving the sound field. These are the fluctuating applied
stresses as in Lighthill’s theory, and the fluctuating force with which solid boundaries interact with the
fluid as in Curle’s theory. Lighthill (1952) and Curle (1955) have provided definitions for the intensities of
sound generated by either free field turbulence or turbulence interacting with solid bodies. The dominance
of both phenomena are studied by Michalke (1989). Howe (2003) summarized the total power radiated in
turbulent regions by quadrupoles and dipoles respectively as

Πq ∝
V0
`0
ρ0u

3M5 (2.34)

Πd ∝ Aρ0u3M3 (2.35)

In here, `0 is the length scale of large energy-containing eddies, V0 is the volume of the turbulent region,
and A is the total surface area wetted by the turbulent flow. In Figure 2.6 an eddy radiating sound in a
turbulent region is given.

Figure 2.6: Eddy radiating sound in a turbulent region as a quadrupole (Howe (2003)).

Definitions of the total radiated sound arise from exact solutions in integral form. The ratio between both
sound radiating sources is

Πq

Πd
∝

V0

`0

A
M2 (2.36)

Details of the flow determine values of V0/`0 and A. However, a rough estimation of the relation can be
made regarding pipe flow including an orifice. Consider a pipe of length L, with `0 = xD, for 0 < x ≤ 1.
This results in

V0

`0

A
=

1
4πD

2L

xD

πDL
=
x

4
(2.37)

12



CHAPTER 2. REVIEW OF LITERATURE

Therefore, sound produced by turbulence near surfaces by dipole is dominant with a factor ∼ M−2

compared to sound produced by quadrupoles (Curle (1955); Howe (2003); Lighthill (1952); Michalke (1989);
Rienstra and Hirschberg (2001)). Besides sound radiation by compact bodies, this also holds for non-
compact bodies, as in turbulence interacting with edges and corners (Howe (2003)). Thus, for M � 1, it
is legit to mainly consider dipoles as sound radiating sources in bounded flow situations as investigated in
this thesis.

Note that the fundamental frequency at which sound is generated by the two phenomena is different. The
fundamental frequency of the dipole is half of the fundamental frequency of a quadrupole. When looking at
the turbulent stresses, quadrupole are proportional to the inertial term (fluctuations in velocity squared).
The dipole is only proportional to the fluctuating velocity (Curle (1955)).

2.7 Exact solution to Curle’s analogy

An exact solution to Curle’s analogy could give insight in the relation between the force exerted on the
fluid and the generated noise field. A complete derivation of this coupling is given in Appendix A. Using
Green’s functions for fixed and impermeable surfaces (no monopole source), the exact solution to Curle’s
analogy results

ρ′(xi, t) = ρ(xi, t)− ρ0 =
∂2

∂xi∂xj

∫∫∫
V

[
Tij

4πc20|xi − yi|

]
dV − ∂

∂xi

∫∫
∂V

[
pni

4πc20|xi − yi|

]
dS (2.38)

Under the assumption that dipole sources are dominant over quadrupole sources and that the flow velocity
is low, a more usable expression results given as (Atassi (2020))

ρ′(xi, t)c
2
0 =

[
∂Fi(τ)

∂τ
+
Fi(τ)c0
|xi − yi|

]
τ

cos(θ)

4π|xi − yi|c0
(2.39)

Note that in between brackets both a long and short distance term are present respectively. The term
outside the brackets defines the shape of the field, as seen in Figure 2.5.

2.8 Experimental research

The governing equations of fluid are non-linear making it difficult to accurately predict the sound pro-
duction of fluid flows (Hirschberg (2007)). Because of this, an experimental approach is a promising way
of investigating acoustic noise in pipes induced by orifices. This, however, is only possible for the direct
effects by the source term. The source term itself is hard to measure.

Agarwal (1994b) measured pressure fluctuations close and far from sources. In both regions, the content
of power spectra are found to be much higher than those for undisturbed flow. As far downstream the flow
statistics have returned to their undisturbed state, there the increased content is attributed to propagating
acoustic waves. These modes induced by the orifices are attenuating when moving away from the disturbing
source (Agarwal (1994a)). Qing et al. (2006) measured the pressure fluctuations in the turbulent region
and concluded that orifices significantly disturb pipe flow locally. These are typically hydrodynamic rather
than acoustic. The intensity of pressure fluctuations is seen to increase with mass flow rate. Additionally,
the energy content at lower frequencies is seen to decrease moving from the orifice. Spazzini et al. (2001)
studied flow behavior over a backward-facing step and concluded that low frequency fluctuations are related
to a flapping motion. High frequency fluctuations correspond to vortex formation and shedding at the step.
This behavior might be equal in flow through orifices. Anantharaman (2014) has indicated low frequency
flapping motions of single-hole orifice jets being sustained by the large recirculation zones. He concluded
this to happen at Strouhal number of approximately 0.02 based on the hole velocity and the difference
in internal diameters of the pipe and orifice. Measured and computed normalized whistling frequencies of
single-hole orifices are found to be St ≈ 0.2-0.4 based on the hole velocity and orifice thickness (Lacombe,
Moussou and Aurégan (2011); Moussou, Testud, Hirschberg et al. (2007); Testud, Aurégan, Moussou and
Hirschberg (2009)). Assuming that vortex shedding is dominating the whistling phenomenon, this high
frequency fluctuating component is contributed to that.

At the location where the flow reattaches to the pipe wall, which is varying in time (Bull and Agarwal
(1983)), the wall pressure fluctuations are highest according to Tao et al. (2017). At that wall location
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prms-values are even higher than on the orifice surface. Additionally, Tao et al. (2017) found that on the
orifice plate, the highest surface pressure fluctuations are located at the inner upstream corner. Heenan and
Morrison (1998) have studied a backward-facing step as well. They concluded that the peak prms-values
can be attenuated using a permeable surfaces at the location of reattachment.

Last, some effort is put in the scaling of pressure measurements to estimate fluctuating force behavior.
Moussou (2006) scaled wall pressure measurement data in a water pipe subjected to an orifice. As a
function of frequency, the force spectrum is scaled as ΦFF ∝ f−3.2. Scaling laws are important in the
characterisation of the source term. Measuring the fluctuating forces will namely remain a difficult task
as non intrusive accelerometers have to be applied at the orifice plate. This is not possible in the current
test setup of ASML.

2.9 Computational Fluid Dynamics studies

Supercomputing power has been growing exponentially which makes doing CFD affordable (Pope (2004)).
However, despite the enormous growth in computing power, Direct Numerical Simulations (DNS) still
remain out of reach for practical usage. Additionally, DNS may not be needed to get solutions for en-
gineering purposes (Chaouat (2017)). Regarding the flapping motion and the vortex shedding being the
dominant phenomena in the sound generation process, it is assumed that only resolving for larger scales is
sufficient (Pope (2004)), hence LES is sufficiently accurate for the work done in this thesis. LES is namely
able to resolve large scales of motion and being a transient solver. Along with DNS and LES solving
the transient problem, time-averaged methods do exist obtaining flow information. A method doing so
is Reynolds-Averaged Navier-Stokes (RANS) which averages the Navier-Stokes equations. This method
is not suitable for studying acoustics, but nonetheless can give useful insights in flow behavior and will
therefore also be applied in this thesis. With an unsteady version of RANS, transient solutions can be
obtained, referred to as URANS. But, in the URANS approach turbulent fluctuations of flow quantities
are not resolved. Therefore URANS is neither suitable for this study. A hybrid RANS-LES is also possible,
but requires very specific turbulence specification at the boundaries (Dhamankar, Blaisdell and Lyrintzis
(2018)).

In DNS and LES, methods do exist to compute or resolve the acoustics directly. Direct Noise Computation
is one of those but is computationally expensive and sensitive to errors (Alenius (2012)). For example
Lacombe et al. (2010) already have used LES acoustics to simulate the whistling ability of an orifice
plate. Rütten, Meinke and Schröder (2001) have performed LES of 90◦ pipe bends and found pressure
fluctuations at Strouhal numbers in the same range as measured values. Piellard and Bailly (2010) have
tried a two-step approach to determine aeroacoustics in ducted diaphragm flow. This required the addition
of an acoustic mesh for interpolation with an acoustic theory. Results did show important differences in
terms of acoustic levels. See the work of Alenius (2012) for a full literature review on using LES to directly
or indirectly capture the sound field. To summarize; in compressible simulations care must be taken that
phase errors by dispersion might lead to errors in the sound cancellation. Additionally, solutions are
sensitive to boundary conditions. Solving incompressible flow is also an option. According to Wagner
et al. (2007): ‘An additional assumption, commonly used, is that feedback from the acoustic field to the
source is negligible. Hence, we can calculate the source term from a numerical simulation that ignores any
acoustic wave propagation and subsequently predict the sound production outside the flow. In extreme
cases of low-Mach-number flow, a locally incompressible flow simulation of the source region can be used
to predict the (essentially compressible!) sound field.’.

Because of the above, incompressible LES is found sufficient for the goal of this thesis. Namely, the source
term can be captured with this, without the need for an acoustic field description. Since measuring the
acoustic field lies within the abilities of ASML, no additional effort is taken to simulate this sound field
in ways which require more effort. Note that no pressure fluctuations from the acoustics are expected in
incompressible LES. A full description of the principles of LES is given in Chapter 4.

2.10 Conclusions

Review of literature is performed to find answers to the research questions which have to be answered
before simulations can be started. From all the above, the following conclusions can be drawn
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• FIV disturbances arise from the production and dissipation of turbulence kinetic energy. This phe-
nomenon is always present in flow through orifices and is partly responsible for the creation of the
pressure drop. In the jet-wake region two mechanism are found to generate significant noise. These
are a low frequency flapping motion, and a higher-frequency unsteady vortex shedding. The first
mechanism, which is the stretching of vortices with respect to a body, or the acceleration of fluid on
a surfaces, is thought to generate the most acoustic content. The frequencies that belong to these
phenomena are for now estimated to be around 20 to 1500 Hz. Thus; with this the mechanisms that
generate acoustic noise are described.

• Two sources are accountable for the generation of acoustic noise content when no mass is injected
or leaking. These sources are dipoles and quadrupoles. Dipole noise is arising from a force applied
by a body to the fluid and is physically described as a fluctuating reaction force of a body. Quad-
rupole noise is generated by the turbulence-turbulence interactions, and are physically described as
fluctuating stresses in fluids. In the presence of a solid body perpendicular to the flow direction,
significant noise is attributed to dipole noise, which is only true when Mach number are lower than
one. As of this, the fluctuating force of the body on the fluid is to be investigated in this thesis. All
in all; one single source term plays a dominant role in generating the acoustics.

• As for now, simulating the source term using incompressible LES is regarded as a promising method.
Associated accuracy and computational costs are still under investigation. It is chosen not to capture
any form of acoustic information with the simulation either simulation directly or using a theory to
calculate. So; LES is promising, but the accuracy and applicability have yet to be investigated.
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Chapter 3

Review of Experimental Data

In line with previous experimental studies, see Section 2.8, at ASML significant amount of experimental
studies are performed to understand acoustic noise and subsequently design to prevent for this. Studies
are performed by Remco van de Meerendonk, Vinod Anantharaman, and Rens Liebrand (ASML (2020)).
Additionally, experiments are performed by Shravan Kottapalli at the TU/e (Kottapalli (2020)). All
studies mainly focus on wall pressure fluctuations in non-disturbed straight water pipes and water pipes
with an orifice. An often applied single-hole orifice in machines of ASML is the SS20 which has an area
ratio of 20%. In pipes and hoses of standard diameter, Dp = 9 mm, these orifices have a hole diameter of
Dh = 4 mm. Mainly short and sharp orifices are applied having a thickness ratio of th/Dh = 0.5 where th
is the hole thickness. A schematic of this part is given in Figure 4.3.

Both the hydrodynamic and acoustic noise are of interest and therefore the experimental data obtained
by colleagues is reviewed, analyzed and post processed. The hydrodynamic wall pressure fluctuations
in straight pipes as well as wall pressure fluctuations in the jet-wake region are essentially important to
compare the LES results with. Acoustic noise measurements give insight in the nature of the pressure
fluctuations far up- and downstream of the source. Note that the experimental data sets can be requested
(ASML (2020)).

3.1 Experimental setup

Pressure fluctuations are measured with pressure transducers. An experimental setup is created previously
explained in the work of Anantharaman (2014). This setup is used at ASML and TU/e to measure
hydrodynamic wall pressure fluctuations in the jet-wake region and to measure acoustic wall pressure
fluctuations in the far field. In this experimental setup the SS20 orifice plate can be included. At ASML
the water cabinet used in actual machines is applied to drive flow. At the TU/e a significantly smaller
pump is applied.

Measurements are performed using water at a constant temperature of 22 ◦C. At this temperature, the
dynamic viscosity is µ = 9.532× 10−4 Pa s and the density is ρ = 998 kg/m3. In this thesis the flow
disturbances are studied at a bulk Reynolds number of Re = 10000 expressed as

Re =
ρUbDp

µ
(3.1)

In here Ub is the bulk velocity. This Reynolds number is marginally in the turbulent regime and is close
to the Reynolds number of most performed experiments. Additionally, being in the lower Re range results
in relatively large turbulent structures. This is computationally beneficial when performing LES. The
corresponding bulk velocity is calculated to be Ub = 1.06 m/s. Small deviations in Re can be scaled for.
Specifications of performed experiments are given in Table 3.1.
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Table 3.1: Specifications of the experiments performed at ASML and TU/e.

Type Restriction Location Re Ub [m/s] Frequency [Hz] Pump
Straight pipe - - 10657 1.18 0 - 12800 No

Orifice (ASML) SS20 -2,1,2,3,6,10D 11022 1.17 0 - 800 Yes
Orifice (TU/e) SS20 -2,1,2,3,6D 10000 1.06 0 - 45000 Yes

Orifice SS20 ≈ 21D 10489 1.11 0 - 12800 Yes

3.2 Post processing

Post processing of previously reviewed experimental data is required. To study acoustics, the mean is
always subtracted from signals first. The resulting pressure fluctuations in time are studied regarding the
content as a function of frequency. This is done estimating power spectral densities (PSD) using Welch’s
method Welch (1967). A PSD gives information about a signal’s power as a function of frequency. This
helps to understand which mechanisms generate noise because the frequency can be related to a geometry
and flow characteristics. A power spectral density of a variable φ is given as Φφφ. A non-dimensionalized
PSD is denoted by Φ∗φφ. The frequency can be non-dimensionalized by

St =
fDp

Ub
(3.2)

Signals are divided into eight segments with an overlap of fifty percent. Segments are windowed using a
Hamming window. After computing the Fourier spectrum, segments are averaged to generate the PSD.
Note that the area under the PSD is not affected by the amount of segments or degree of overlapping.
However, details can lack when for example too many segments are used. From a PSD, the root mean
square value of the particular signal is determined as done by Qing et al. (2006). For the pressure this
is

prms =

√∫ ∞
−∞

Φpp(f) df (3.3)

With this, the fluctuating behavior of a specific frequency range can be considered. Especially, as content
at very low frequencies is produced by system behavior rather than the disturbance source itself, this can
result in more fair comparison of flow behavior. The frequency range of interest for this work is 10Hz to
3000Hz. The integral values are determined with the trapezoidal function in MATLAB.

The wall shear stress can be determined with

τw =
1

2
ρU2

bCf (3.4)

Blasius (1913) provided an empirical formulation to calculate the required skin friction coefficient for fully
developed straight pipe flow as

ff =
0.316

Re
1
4

, Cf =
ff
4

(3.5)

3.3 Straight pipe measurement data

In straight pipes, wall pressure fluctuations are rather low. So to study these fluctuations, it is important
to disregard any additional disturbance sources by the system. Van de Meerendonk (ASML (2020)) has
studied pipe wall pressure fluctuations using potential energy to drive the flow. With a water reservoir at
height, additional disturbances of the pumps are therefore excluded. Despite different Reynolds numbers,
non-dimensionalizing PSD’s does lead to a similar PSD according to W. Blake (1984). He showed this
existing merge of non-dimensionalized PSD’s for Reynolds number up to one hundred-thousand. Therefore
it is legit to compare wall pressure fluctuations of simulated straight pipe flow using LES with this exper-
imental data set. In Figure 3.1a PSDs of pipe wall fluctuations in an empty pipe are depicted for different
Reynolds number. Note that the normal form is plotted as the null case cannot be non-dimensionalized.
A significant content is measured at the lower and higher frequency range without the motion of flow
(Re = 0). This is regarded as a background error. The PSDs at close Reynolds numbers do coincide.
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However, prms-values of wall pressure do decrease significantly as a function of decreasing Reynolds num-
ber found by van de Meerendonk. This is in line with the straight pipe wall pressure measurements done
by Selvam, Öngüner, Peixinho, Zanoun and Egbers (2018).
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Figure 3.1: a: PSD of hydrodynamic wall pressure fluctuations in a straight pipe for different Reynolds
number. b: Comparison of hydrodynamic wall pressure fluctuations measured at ASML normalized with
the hydrodynamic pressure q. The orifice is located at z/D = 0.

3.4 Hydrodynamic pressure fluctuation measurement data

The hydrodynamic noise in water pipes including an orifice is measured by Anantharaman and Kottapalli
(ASML (2020)). Results are non-dimensionalized with the hydrodynamic pressure q = 1

2ρUb
2 to compare

with results at different mass flow rates. Unfortunately Anantharaman only considered a frequency up to
800 Hz, which is rather low. Kottapalli considered a frequency up to 45000 Hz and measured with a bulk
velocity equal to the bulk velocity used in this thesis. In Figure 3.1b the normalized wall pressure fluctu-
ations are depicted with the orifice located at z/D = 0. The highest pressure fluctuations are measured to
occur close to the orifice. Around z/D = 6 the acoustic pressure fluctuations become dominant. The level
of pressure fluctuations reached downstream of the jet-wake region is roughly equal to the prms upstream
of the orifice. The higher pressure fluctuations measured at ASML are attributed to the additional noise
generated by the water supply system.

3.5 Acoustic pressure fluctuation measurement data

Rens Liebrand (ASML (2020)) measured acoustic wall pressure fluctuations far up- and downstream of the
disturbing component using the available test setup. Details are added to Table 3.1. This experimental
data allows investigation of the net effect of the noise source as pressure transducers are located out of the
hydrodynamic region. Pressure transducers are placed≈ 21D up- and downstream of the orifice. Regarding
Figure 2.5b, a theoretical dipole radiates pressure waves up- and downstream which are perfectly out of
phase. To study the power content introduced by the dipole, both signals should be added or subtracted,
after which the PSD is calculated. If both signals are perfectly out of phase at every frequency, the signals
are expected to cancel out when adding them in time domain first. In contrast, for a theoretical pure
dipole the energy content is expected to increase when both signals are subtracted in time domain first.
Corresponding PSDs after both adding and subtracting the signals in time domain first are illustrated in
Figure 3.2. The PSDs are post processed to remove peaks at frequencies of a multiple of 50 Hz resulting
from poor grounding. Figure 3.2a illustrates that indeed power content is increased when subtracting the
signals in the time domain. This is the case for a frequency range of roughly 10 to 2000 Hz. In Figure
3.2b the decrease of power content is depicted for a frequency range of roughly 10 to 2000 Hz when adding
both the signals in time domain. This presumably indicates that in that range the dipole effects are strong
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Figure 3.2: PSD of wall pressure fluctuations far up- and downstream of the orifice. a: Supplemented with
a PSD of subtracted time signals. b: Supplemented with a PSD of added time signals.

compared to other source types. In the lower frequency range the opposite behavior is visible. Addition of
the signals results in an increase in content, whereas subtraction results in a decrease. This might indicate
the in-phase noise contribution of the pump.

Now the contribution of the dipole source term to the pressure spectrum is known, the actual source
term is computed using the exact solution to Curle’s analogy, given in Equation 2.39. The discretization
used for this is elaborated on in Appendix A. Figure 3.3a illustrates the resulting PSD of the force signal.
Comparing with the pressure spectrum, it is noticed that a significant force is required to generate pressure
fluctuations 21D up- or downstream. Using the exact analogy and taking the integral of the force spectra,
the required Frms to generate the pressure spectrum is calculated as a function of distance between source
and observer. This is depicted in Figure 3.3b.
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Figure 3.3: a: PSD of the force resulting from the exact solution to Curle’s analogy. b: Root mean square
of the force required to generate subtraction graphs in Figure 3.2a as a function of the distance between
source and observer.

A significant increase in the required force is observed. The exponential decay is physical, but in bounded
flow the pressure content is not expected to decrease that significantly with the distance, see for example
Figure 22 of Agarwal (1994b). In other words, the calculated Frms-values are significantly above the
expected value. One hypothesis why large force fluctuations are required to generate the acoustic pressure
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fluctuations is that free field sound propagation is considered. If this is the case, bounds might need to be
incorporated to get solutions in the right order. Walls namely do increase the pressure at the source and
lead to scattering, the problem becomes non-compact, and the source term is lacking acoustical information
(Schram (2009); Schram, Anthoine and Hirschberg (2005)).

3.6 Turbulent pipe LDV measurement data

LES will be performed in the same Reynolds number range as in the presented experiments. To analyse LES
results, reference data is required. Either experimental or DNS data are suitable for that. Den Toonder and
Nieuwstadt (1997) have carried out Laser Doppler Velocimetry measurements of pipe flow at a Reynolds
number of Re = 10000. Based on pressure drop measurements, they provided the friction velocity defined
as

uτ =

√
τw
ρ

(3.6)

With the density and bulk velocity given, the friction coefficient is calculated to be Cf = 8× 10−3 using
Equation 3.4. Using Equation 3.5, the skin friction coefficient is calculated to be Cf = 7.9× 10−3 which
agrees well with the experimentally obtained value by Den Toonder and Nieuwstadt (1997). For a flow
with Re = 10000 and Ub = 1.06 m/s, the corresponding wall shear stress is calculated to be τw = 4.44 Pa
using Equation 3.4.

Flow statistics of axial and radial components have been measured by them, lacking the tangential com-
ponent. Therefore the TKE cannot be computed, especially as pipe flow is highly anisotropic. Therefore
the experimental data is compared with a DNS set of El Khoury et al. (2013) at Re = 11700, see Figure
3.4. The distance from the wall is normalized as

y+ =
yν

uτ
(3.7)

The wall distance is defined as (0.5 − r/D)+ as the origin of the coordinate system is in the middle
of the geometry. Note that the shear stress component ur ′uz ′ is flipped in sign for illustration reasons.
Additionally, note that in Cartesian coordinates this stress component is negative in one of the half-heights
in xz-plane as will be shown later. Because of circumferential symmetry, ut′uz ′ and ur ′ut′ are zero (Pope
(2001)). The normalized velocity profiles do match well, see Figure 3.4a, as well as the stress components
of fluid, see Figure 3.4b. Therefore it is assumed that flow at Re = 10000 can also be compared with the
DNS data of El Khoury et al. (2013).
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Figure 3.4: Comparison of the flow statistics of DNS data by El Khoury et al. (2013) (Re = 11700) and
experimental data by Den Toonder and Nieuwstadt (1997) (Re = 10000). The experimental measurement
error is included. a: The axial velocity normalized with the friction velocity. b: The turbulent stress
components in fluid normalized with the friction velocity squared.
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Chapter 4

Numerical Approach

As already mentioned in Section 2.9, LES is a promising method to obtain transient data of flow char-
acteristics for engineering purposes. In this chapter the numerical approach of LES will be elaborated
on. Information about the numerical solver will be provided, as well as a description of the mesh and
setup conditions. The chapter will be concluded with a summary of the main simulation settings of all
simulations done. In Appendix B a manual for setting up a simulation is provided. Additionally, steps in
this numerical approach regarding RANS simulations are provided in Appendix C.

4.1 Large Eddy Simulation

To resolve all turbulent length and time scales, the computational mesh must be able to represent the
whole range of turbulent structures; from the large energy-containing scales all the way to the smallest
dissipative scales, see Equations 2.9 and 2.10 and Figure 2.2. This is done in DNS and requires an enormous
amount of computational effort. Despite its accuracy, this method remains out of scope for all engineering
approaches (Chaouat (2017)). Especially, if the quantities of interest and the rate-controlling processes
are determined by the resolved large scales, which may be expected (Pope (2004)).

In LES, only the larger turbulent scales are resolved for, see Figure 2.2b. This means that influences of
the smaller scales are not taken into account directly. To account for that, a so-called subgrid-scale (SGS)
model is included for modelling these smaller scales. This SGS model is of huge importance to bridge the
gap between the large energy-containing eddies `0 and the dissipative scales η ensuring that the correct
amount of TKE is dissipated from the bulk flow, see Figure 2.2a. It is justified to account for the smaller
scales using a SGS model as the smaller scales are universal at sufficiently high Reynolds numbers according
to the first similarity hypothesis of Kolmogorov (1941). At the Taylor microscale, viscosity significantly
starts affecting the dynamical behavior of turbulent eddies, and TKE starts to be dissipated into heat,
see Figure 2.2b. For scale resolving simulations to provide good results, Addad, Gaitonde, Laurence and
Rolfo (2008) have shown that the maximal local grid size, ∆, has to be limited by the turbulent scale at
which the dissipation region begins. Therefore, the resolved to under resolved scales boundary should lie
in the inertial subrange. Thus, in practice the boundary should be chosen at least lower than the Taylor
microscale. Note that when a grid is significantly refined LES tends to DNS (Speziale (1998)). Ideally,
the grid is refined until a grid-independent LES is obtained. From that point on, the philosophy of LES
loses its meaning for further grid refinement. Because of that, it should be bared in mind that a grid
refinement study is very important so dependency of simulation results on the computational grid can be
investigated.

LES distinguishes between unresolved and resolved scales by spatial filtering. Unresolved scales are char-
acterized by a residual field

φ̌(xi, t) = φ(xi, t)− φ̃(xi, t) (4.1)

Each variable φ solved for is thus decomposed into a filtered value φ̃(xi, t) and a sub-filtered value φ̌(xi, t)
as

φ(xi, t) = φ̃(xi, t) + φ̌(xi, t) (4.2)
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Typically φ represents velocity components or pressure. Filtered values will be resolved on grids with a
filter width, ∆, equal to the grid spacing, h, in case of numerical LES (Pope (2004)). The filter width is
defined as

∆ = (∆x∆y∆z)
1/3

(4.3)

Applying a filter to the incompressible mass and momentum conservation equation, see Equations 2.1 and
2.3, results in the to be resolved part of the solution

∂ũi
∂xi

= 0 (4.4)

∂ũi
∂t

+
∂ (ũiũj)

∂xj
= −1

ρ

∂p̃

∂xi
+

∂

∂xj

[
ν

(
∂ũi
∂xj

+
∂ũj
∂xi

)
− τSGSij

]
+
Fi
ρ

(4.5)

Note that an additional term is introduced, τSGSij , which is the residual-stress tensor or SGS tensor defined
by

τSGSij = ũiuj − ũiũj (4.6)

This term is added because the product ũiũj could not be directly filtered as it appears in Equation 4.5.
Additionally, as is the case for RANS, also in LES the filtered nonlinear convection term would be a major
difficulty and must be modelled.

4.1.1 SGS model

In STAR-CCM+ the Wall-Adapting Local-Eddy Viscosity (WALE) SGS model by Nicoud and Ducros
(1999) provides the subgrid scale turbulent viscosity, νT , required for modelling of the SGS stress tensor.
The advantages of this method over for example the Dynamic Smagorinsky SGS is its applicability near
walls, its relative time efficiency, and its functioning without any form of near-wall damping. In STAR-
CCM+ the eddy viscosity modelling for subgrid stresses is done by using

τSGSij − 1

3
τSGSkk δij = −2νT S̃ij (4.7)

with the filtered rate-of-strain tensor given by

S̃ij =
1

2

(
∂ũi
∂xj

+
∂ũj
∂xi

)
(4.8)

Note that on the left only the deviatoric stress is left after subtracting the hydrostatic stress since this is
the only relevant part for incompressible flow. The turbulent viscosity is provided as

νT = ∆2Sw (4.9)

Where Sw is the deformation parameter defined as (

Sw =
(SdijS

d
ij)

3/2

(SdijS
d
ij)

5/4 + (SijSij)5/2
(4.10)

It is a strain rate tensor and consists of velocity gradients from the resolved velocity field. Here Sdij is
defined as (STAR-CCM+, 2018, p. 7038)

Sdij =
1

2

[(
∂ui
∂xj

)2

+

(
∂uj
∂xi

)2
]
− 1

3
δij

(
∂uk
∂xk

)2

(4.11)

The length scale ∆, or filter width, is defined in terms of the cell volume Vc as

∆ = CwV
1
3
c (4.12)

Cw is a model constant having a default value of Cw = 0.544, which works for homogeneous isotropic
turbulence as bounded flow. Substituting all into the filtered Navier-Stokes equations results in the LES
equations

∂ũi
∂t

+ ũj
∂ũi
∂xj

= −1

ρ

∂p̃

∂xi
+

∂

∂xj

[
(ν + νT )

(
∂ũi
∂xj

+
∂ũj
∂xi

)]
+
Fi
ρ

(4.13)

Now an additional term is present which dumps eddy viscosity in the domain to represent subgrid scale
stresses.
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4.1.2 Implicit LES

If the truncation error in the finite volume scheme is more or less a dissipation-like term, non-physical
numerical dissipation will occur. Especially on coarse grids, this effect might be significant. In essence it
has the same effect as the explicit SGS model dissipating energy from the field. Relying on the numerics
can provide some subgrid scale closure (Adams and Hickel (2009)) called implicit LES (ILES). So when
disabling SGS models, still the right amount of energy dissipation might be achieved by information leakage
due to numerical dissipation. This is legit as the leading-order truncation term of conventional SGS models
is similar in form and magnitude to the truncation term introduced by most numerical schemes (Fernandez,
Nguyen, Roca and Peraire (2016); Fureby and Grinstein (1999)). This method is practically applied in
STAR-CCM+ by changing the model constant Cw in Equation 4.12 to a reasonable low value resulting in
an insignificant modelled turbulent viscosity and therefore SGS stresses.

4.2 Solver

In STAR-CCM+, the Finite Volume Method (FVM) is applied, being successful in solving fluid flow
problems. FVM is based on conserving the conservation laws over the surfaces of cells around nodes in
a mesh. A solvable system of algebraic equations is obtained by discretizing the governing equations in
space and time (STAR-CCM+, 2018, p. 6934). Integrating the convection-diffusion equation over a control
volume V and applying Gauss’s divergence theorem results in

d

dt

∫
V

ρφdV +

∫
A

ρuiφdA =

∫
A

µ
∂φ

∂xi
dA+

∫
V

SφdV (4.14)

where φ represents a scalar property to be transported and Sφ expresses the generation or destruction of
fluid property φ. It consist of a transient term, a convective flux, a diffusive flux, and a source term.

4.2.1 Segregated flow solver

The segregated flow solver solves the integral conservation equations of mass and momentum in a sequential
manner for solution variables ui and p (STAR-CCM+, 2018, p. 6947). In here, a pressure-velocity coupling
algorithm corrects the pressure to satisfy the continuity equation with the sought velocity field. In this
predictor-corrector approach, the pressure results therefore from this pressure-correction equation.

4.2.2 Convection discretization scheme

Convection fluxes over cell faces can be discretized using different schemes. Along with LES, the Bounded
Central-Differencing scheme is suitable (STAR-CCM+, 2018, p. 3152), being a combination of a central-
differencing (second-order accurate) scheme and an upwinding scheme (first- or second-order accurate).
Namely, pure upwinding is very robust but rather inaccurate, whereas central differencing provides accurate
solutions but is not very robust (Van der Weide (2018)). Pure first order upwinding causes turbulent
kinetic energy to decay unnaturally fast especially on coarse computational grids, referred to as artificial
dissipation. Second-order upwinding is characterized by dispersive errors and smear solutions less compared
to first-order upwinding and increases accuracy. The different errors are returning in the residual plots as
the first-order upwinding schemes results monotonically decreasing residuals whereas this is not the case
for second-order upwinding schemes. So the approach in which fluid property φf at the face is determined
effects stability and accuracy of numerical schemes. In Figure 4.1a three cells are depicted with nodal
values of φ at upwind, central and downwind locations. To come up with a convection boundedness
criterion, normalized values are introduced being

ξf =
φf − φU
φD − φU

, and ξC =
φC − φU
φD − φU

(4.15)

To avoid non-physical oscillations in the solution, φC and thus φf have to be locally bounded between φU
and φD. Therefore no non-physical oscillations are present if

φU ≤ φC ≤ φD , or φD ≤ φC ≤ φU (4.16)

This boundedness is summarized in the Normalized Variable Diagram (NVD) plotting ξf as a function of
ξC . Conditions for boundedness are
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(a) (b)

Figure 4.1: FVM convection discretization a: Stencil for interpolating cell face values from known cell-
center values.

• For 0 ≤ ξC ≤ 0, ξf > ξC which means that the bounded region is above the line ξf = ξC . Additionally,
in that region ξf should be below one.

• For ξC < 0 and ξC > 1, ξf is equal to ξC .

Convective fluxes are computed with Bounded Central-Differencing for the fluid property at the face, φf ,
as

(ṁφ)f =

{
ṁ φFOU , for ξC < 0 or ξC > 1
ṁ (σφCD + (1− σ)φSOU ) , for 0 ≤ ξC ≤ 1

(4.17)

When ξC < 0 or ξC > 1 the face value is determined by a first-order upwinding (FOU) scheme to maintain
boundedness. ξf then follows the blue line in the NVD, see Figure 4.1b. Depending on the stream
direction, the interpolated value φf is the upwind value and is only first order accurate. For 0 ≤ ξC ≤ 1, a
second order accurate scheme is applied. In here, σ, is introduced which satisfies σ(0) = 0, and σ(ξ) = 1 for
ξC ≥ ξubf , with σ being smooth and monotone. This means that when ξC ≥ ξubf , pure central differencing
(CD) is applied. If this criterion is not met, a combination of Second-Order Upwinding (SOU) and CD is
applied. ξubf is the Upwind Blending Factor (UBF). When this value is chosen low, this results in more
central differencing, see Equation 4.17. CD provides accuracy, whereas SOU provides robustness. With
ξubf the proportion of both can thus be tuned. The second order accuracy is achieved in the green part
of the NVD, see Figure 4.1b. A STAR-CCM+ default value of ξubf = 0.15 is considered conservative but
is said to reflect optimization for accuracy and performance (STAR-CCM+, 2018, p. 3159). Assuming
that the slope of σ(ξC) is constant and using bounded central differencing, ξf (ξC) follows the red line,
see Figure 4.1b. Note that for ξubf < 0.15 another line might be followed. Linearity is preserved so the
solver does not switch from one scheme to another. This means that φf is determined with upstream and
downstream cell values that are determined with the same scheme and therefore no first order truncation
error is introduced (Waterson and Deconinck (2007)). When assuming uniform cells, this linearity should
be preserved around ξC = 0.5. This is not the case using e.g. a minmod scheme when choosing ξubf = 0.5,
which leads a lot of numerical diffusion.

4.2.3 Temporal discretization

The transient term in the transport equation is discretized using an implicit scheme. This requires the
subdivision of time in time-steps and uses the solution at the current time step. The major advantage
of the implicit method over the explicit method is its stability, helpful when applying large timesteps. A
disadvantage is its computational expensiveness as an iterative (or matrix) solver has to be used as the new
value appears at both sides of the equation (Van der Weide (2018)). The transient term is approximated
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using a second-order temporal implicit differencing scheme at the current time step n as

d

dt
(ρφV ) =

3 (ρφV )
n − 4 (ρφV )

n−1
+ (ρφV )

n−2

2∆t
+O((∆t)2) (4.18)

This uses only two previous solutions. However, when the solution at more previous timesteps are included,
the leading-order truncation order can be reduced. When using five time levels the second order truncation
error is decreased with a factor 2.64. The use of time levels thus enhances accuracy, but the scheme is
harder to stabilize (STAR-CCM+, 2018, p.2892).

4.2.4 Accuracy LES

Having introduced the possible error sources in LES, it is of importance to check the accuracy of the
simulations. An approach judging the accuracy of LES on ∆ is introducing turbulent statistic Q which
has contributions from both the energy-containing and dissipative eddies as done by Pope (2004). Qm is
an estimate to Q defined as

Qm = Qw +Qr (4.19)

where Qw comes from the resolved field and Qr denotes its residual contribution, and its dependency on
∆ is depicted in Figure 4.2.

Figure 4.2: Turbulent statistic Q as a function of the filter width ∆ (Pope (2004)).

At Qm0 DNS accuracy is reached and QmI represents an intermediate asymptote indicating that ∆ is in the
intertial subrange and most of the energy contribution is resolved for. Note again that when ∆ < `DI ,
LES loses its meaning. This emphasizes again the need for a grid refinement study. The grid dependency
can be studied for a second order statistic of interest, namely comparing the revolved and modelled TKE.
It is good practice to monitor modeled TKE on rather coarse grids according to (STAR-CCM+, 2018,
p. 3702) and Pope (2004) using

MTKE =
kSGS

kSGS + kres
(4.20)

In Appendix B it is described how to enable the field function kSGS in STAR-CCM+. M denotes the
fraction of turbulent kinetic energy in the resolved motions. A value of one corresponds to RANS and a
value of zero corresponds to DNS. It is recommended to resolve at least 80% of the large scales (MTKE ≤
0.2). Additionally, to quantify the contribution of the SGS model, checking the turbulent viscosity is a
good measure. With respect to laminar viscosity, the dynamic turbulent viscosity ratio is given as

TV R =
µτ
µ

(4.21)

A turbulent viscosity ratio of 10 is considered an acceptable value.
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4.3 Computational domain

In LES, it is important that the flow reaches its fully developed state possible on the computational grid
when approaching the orifice. Fully developed turbulence means that the statistics of the flow properties
indicate invariant behavior in the axial direction downstream a reference location. A geometry with an
upstream length of twenty diameters and a downstream length of ten diameters from the orifice is created.
The same orifice is implemented as done in experiments, See Chapter 3. Pipe and hole diameter are Dp = 9
mm and Dh = 4 mm which result in an area ratio of 20%. The thickness of the orifice is th/Dh = 0.5. The
origin of the cylindrical coordinate system is located in the very middle of the orifice. For the computational
domain see Figure 4.3.

r

20D 10D
2

9
D

z

D

Dh

Flow

= 9mm

Figure 4.3: Schematic of computational domian used in LES with dimensions.

4.4 Mesh

Meshing the domain is an important part in numerically solving fluid flow. The mesh quality is strongly
related to the accuracy of the solution as already discussed. Besides the influence of the filter width itself,
a few general rules regarding cell quality should be followed to get accuracy simulation results, see Figure
4.4. These are

• Having cell aspect ratios ideally around one in regions with homogeneous flow statistics. Larger
gradients are expected close to boundaries. Using prism layers in those regions, the cell aspect ratio
is of less importance. The function of prism layers (PL) is explained later on.

• Guaranteeing the skewness angle to be below 90.0◦ to prevent non-physical solutions (STAR-CCM+,
2018, p. 6941). The skewness angle is the angle between the line connecting two cell centroids and
the face normal, see Figure 4.4a.

• Providing smooth changes of cell volume of adjacent cells, see Figure 4.4b.

• Achieving a face validity, also orthogonality, of minimal 1.0. This is a measure of the face normal
correctness relative to their attached cell centroid, see Figure 4.4c. For very bad cells these face
normals might cross.

These rules are checked running a full mesh diagnostics report. A visualization of these cell criteria is
given in Figure The overall mesh quality is judged by checking

• The cell density in either high- or low-gradient areas.

• The correctness of meshing near walls.

• Effect of grid refinement on convergence and flow statistics.

The bulk region is meshed using polyhedral cells. Polyhedral (14 cell faces) cells are favorable over
tetrahedral cells having more neighbouring cells and therefore better approximate gradients. Besides,
these are less sensitive to stretching. Last, turbulent flows are chaotic and not unidirectional. This means
that the possibility of meeting orthogonality requirements is higher enhancing the reduction of numerical
diffusion. This is especially important in recirculating internal flows (StevePortal (2019e)).
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(a) (b)

(c)

Figure 4.4: Visualization of good computational cells STAR-CCM+ (2018). a: Skewness angle. b: Volume
change. c: Face validity.

Cell sizes in the bulk region are based on the Taylor microscale at the pipe centerline modelled with
RANS, see Appendix C. Namely, a filter width ∆, and thus maximal cell size, equal to this viscous-driven
scale provides good results (Addad et al. (2008)). In Figure C.3 length scales up- and downstream of
the orifice are given. Upstream of the orifice, which is essentially a straight pipe, a cell size of 0.5 mm
should be sufficient for accurately resolving flow with LES. However, note that in the jet region the Taylor
microscale is approximately 0.2 mm, see Figure C.3. Therefore the cell size should not be based on the
Taylor microscale in the pipe region. Besides, note that cell sizes are defined as a function of the volume
of cells, Vc, as (STAR-CCM+, 2018, p. 2478)

Mesh size ≈ 1.2V
1
3
c (4.22)

4.4.1 Near-wall treatment

Near the wall a boundary layer exists characterized by high gradients in the direction perpendicular
to the wall. Therefore a different mesh type will be applied. Prism layers are able to capture these high
gradients. This cell type allows high aspect-ratios without affecting the stream-wise resolution. To simulate
molecular shear effects correctly, the prism layer should have a thickness of at least fifty wall units. In that
region direct effects of molecular viscosity are non negligible according to Pope (2001). In the outer layer
(y+ > 50), direct effects of molecular viscosity on the mean flow velocity are negligible as turbulent shear
stress dominates and therefore no prism layers have to be applied there. The corresponding thickness will
be determined using Equation 3.7 which defines y+. A wall shear stress of τw = 4.44 Pa is used for this as
calculated in Chapter 3.6.

Near-wall regions in turbulent flows are treated in mainly two ways; either resolving (WRLES) or modelling
(WMLES) turbulent structures. WRLES requires y+1 < 1. FVM stores information at cell centers. This
means that the the distance between the cell centroid of the first prism layer to the wall should be smaller
than one wall unit. WMLES requires 1 < y+1 < 5 or y+1 > 30. With WMLES it is not desired to have
an intermediate resolution which ends up in the buffer layer (Salim and Cheah (2009)), see Figure 4.5. In
the end WRLES comes with a higher grid resolution close to the wall which increases the computational
costs. Especially for high Reynolds number flows because the number of grid cells to resolve the boundary
layer over for example a flat plate increases as Re1.76 (Chapman (1979); Pope (2001)). STAR-CCM+
automatically chooses the method of near-wall treatment based on the designed mesh when using the
All-y+ Wall Treatment model. In Figure 4.5 the velocity profile near the wall is depicted. When WMLES
is applied, the viscous sublayer and logaritmic layer can be modelled respectively as

u+lam = y+ , and u+T =
1

K
lnE′y+ (4.23)

In here, K is the Von Kármán constant equal to 0.42 as default, and E′ is the wall function coefficient
which is dependent on roughness function fr as E′ = Er/fr. fr is unity for smooth walls. As default
Er = 9.0. For the buffer layer inside STAR-CCM+ a blended wall law is applied.
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Figure 4.5: Modelling of the wall layer (STAR-CCM+, 2018, p. 3733).

4.4.2 Meshing the pipe region

When simulating a pipe with an orifice still the part upstream of the orifice can be seen as a simple
straight pipe. Bad meshes near walls effect the accuracy of the characterization of flow separation and the
determination forces on walls. This affects integral results as for example the pressure drop. Therefore
meshing near the wall is important. Clear criteria are set up to do so

1. For WRLES: y+1 < 1. For WMLES 1 < y+1 < 5 or y+1 > 30.

2. The stretching factor (SF) of adjacent cells in cross stream direction should be below 1.5 to guarantee
smoothness (SF ≤ 1.5).

3. At least ten prism layer cells in cross stream direction (Np ≥ 10) for wall resolved simulations (STAR-
CCM+, 2018, p. 2379) (depending on Reynolds number). For modelling the inner region at least
two to three cells are required (StevePortal (2019b)).

4. The total prism layer thickness, δp, should be at least fifty wall units (δ+p > 50).

The total prism layer thickness, the number of prism layer cells in cross stream direction, and stretching
factor are mesh generation input variables in STAR-CCM+. Because of a linear increase in prism cell
thickness in cross stream direction, y+1 can be calculated from these variables. The total prism layer
thickness, δ, is related to the thickness of the first prism layer, δ1, as

δp = δp1

Np−1∑
i=0

(
SF i

)
(4.24)

Note that y1
+ = 1

2δp1
+. The distance of the first prism layer cell centroid to the wall can be determined

as

y1
+ =

1

2

δ+p∑Np−1
i=0 (SF i)

(4.25)

With this expression, the stretching factor, the number of prism layers and the total prism layer thickness
are parameters to control y1

+. Please note that additionally the stretching factor between the prism layers
and polyhedral cells should also be small. i.e. a smooth transition from prism layer to bulk region should
be provided. So having relatively large cells in the bulk region, requires a thick adjacent prism layer, δp,last.
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Controversially, this is achieved choosing large stretching factors. Therefore a balance between between
y1

+, SF, Np, and δp,last needs to be found.

Using a wall shear stress of τw = 4.44 Pa, for both applying WRLES and WMLES, mesh properties are
given in Table 4.1. Cross sections of the computational grid are depicted in Figure D.1. Note that WMLES
with y1

+ > 30 is not included as no mesh can be created with the proposed criteria while simultaneously
guaranteeing smoothness between the prism layer and bulk region. According to Equation 4.22, the mesh
size will differ from the cell base size. In a simulation, this cell size is determined following the steps in
Appendix B.7.1. The standard deviation and actual cell size are included in Table 4.1.

Table 4.1: Properties of the proposed computational grids for LES.

Grid 1 Grid 2 Grid 3 Grid 4 Grid 5 Grid 6 Grid 7 Grid 8
Base size [mm] 0.70 0.50 0.50 0.35 0.35 0.35 0.35 0.20
Cell size [mm] 0.86 0.63 0.63 0.43 0.42 0.41 0.42 0.27

Cell size std [mm] 0.118 0.073 0.082 0.059 0.050 0.049 0.066 0.030
No. cells 207k 483k 889k 1882k 610k 1069k 815k 3442k
Np 10 12 25 25 5 12 8 10

δp [mm] 0.70 0.70 0.70 0.70 1.00 1.00 1.00 0.70
δ+p 49 49 49 49 70 70 70 49
SF 1.5 1.5 1.3 1.3 1.2 1.2 1.5 1.1
y1

+ 0.22 0.10 0.04 0.04 4.70 0.84 0.71 1.54
δp,last [mm] 0.24 0.24 0.16 0.16 0.28 0.19 0.35 0.10

Cell sizelast [mm] 0.57 0.45 0.40 0.32 0.36 0.32 0.40 0.19
Layer Mesher PLM PLM PLM PLM PLM ALM ALM ALM

No. extrusion cells - - - - 80 80 80 80

4.4.3 Meshing the orifice region

The rules introduced for the straight pipe do also apply for the region around the orifice. However, the
orifice region has to be treated separately to guarantee a good mesh. Around the orifice namely the
wall shear stress is typically higher requiring a thinner prism layer to the wall to meet the y+1 -criterion.
However, the problem is that the wall shear stress is significantly different on every location of each orifice
surface. The total prism layer thickness is determined from the lowest wall shear stress, ensuring that the
boundary layer is always covered with prism layers (y+ >= 50). Note that this may results in high values
of δ+ for locations where the wall shear stress is high. The value of y+1 , on the other hand, is determined
based on the highest wall shear stress.

Remaining input parameters are SF and Np. These parameters are used to tune the values of y+1 and δlast.
Note that it is intentionally chosen not to decrease the cell size around the orifice to avoid a jump in cell
sizes! Since the cell sizes are determined based on the pipe region (computationally less expensive), the cell
sizes do not match the decrease in δp around the orifice because of the higher wall shear stresses. Therefore,
it is often hard to ensure that δp,last matches the cell sizes of the bulk region while simultaneously meeting
the other mesh criteria based on a higher wall shear stress. For a large δp,last the stretching factor has to
be chosen high whereas the number of prism layers has to be kept low. The latter comes with an increase
of y+1 .

For grids 6 to 8 the number of prism layer cells is decreased to decrease the total number of cells so the
computational time decreases. To guarantee y+1 < 5 for wall shear stresses up to at least τw = 1000 Pa,
the total prism layer thickness is decreases.

Around edges, the prism layer mesher model decreases the total prism layer thickness and number of prism
layer cells. The mesher does that to avoid generating highly skewed cells. However, this results in bad
prism layers, see Figure 4.6a. This is solved by applying the advancing layer mesher which creates more
uniform cell layers and helps to reduce cell skewness, see Figure 4.6b. The cell quality remediation model
is additionally enabled which tracks highly skewed cells. This model treats these tracked cells differently
enhancing stability. Cross sections of meshes around the orifice are illustrated in Figure D.1.
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(a) (b)

Figure 4.6: Mesh grid around orifice using different near wall layer meshing methods. a: Prism layer
mesher. b: Advancing layer mesher.

4.5 Setup conditions

With the meshes being prepared, the setup conditions have to be provided. This involves the choice of a
proper timestep, specification of boundary conditions, and the initialization of the solution.

4.5.1 Time stepping

Temporal resolution is additionally important influencing the accuracy of results. For explicitly discretized
flow solvers, the Courant-Friedrichs-Lewy (CFL) condition by Courant, Friedrichs and Lewy (1928) is a
condition saying that any travelling length of information during one timestep has to be smaller than the
distance between two mesh element centroids. Using implicit discretization as in STARCCM, the CFL
number is no longer a critical measure of stability. However, it still serves as a measure of accuracy when
the truncation error of space and time are of the same order. If the timestep is taken too large, the fluid
crosses one or more cells in that time step. The convective CFL number is given as

CFL =
ui∆t

∆xi
(4.26)

This convective Courant number should be close to 1.0 in the region of interest (STAR-CCM+, 2018,
p. 3703). Besides the CFL number, the turbulent time scale is important as discussed in Section C.4.
Another practical aspect is the highest frequency interested in. According to Nyquist’s theorem, the
sampling frequency should be at least twice as high as the frequency determining the bandwidth. In the
book of Wagner et al. (2007) a more conservative recommendation is suggested calculating the frequency
as one tenth of the inverse of the time step. An maximal frequency of 5000 Hz is looked for. This results
in a time step of ∆t = 2× 10−5 s.

In precursor RANS analysis, the smallest turbulent times scales are found to be t` ≈ 1× 10−4 s in the
orifice region. This corresponds with instantaneous values of the turbulent time scale in LES. In RANS
the smallest time scale is modelled to be tη = 1× 10−5 s. For calculating the CFL number, defining the
maximum jet velocity is possible using conservation of mass (UbAp = uhAh). This results in uh = 5.37
m/s, but this is averaged over the area and averaged in time. With RANS, a modelled maximum velocity
of uh = 7.33 m/s is obtained. This value represents the maximum in the jet, but is time averaged as well.
A maximal instantaneous velocity magnitude in the jet-wake region in LES is assumed to be uh = 10
m/s. With the proposed grids, theoretically the maximal CFL number will be 1.25 using a time step of
∆t = 2.5× 10−5 s. This time step results in an acceptable maximal CFL, the possibility to represent the
Kolmogorov time scale almost everywhere, and meets the maximal frequency criterion. One should keep
in mind that not every cell has an information travelling length equal to the general cell size and therefore
the CFL can be larger for single cells. This is deemed acceptable for the used implicit time integration
scheme.
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4.5.2 Boundary conditions

Applying realistic turbulent inflow conditions at the inlet boundary is found important by Dhamankar,
Blaisdell and Lyrintzis (2017). Optimally, a fully-developed state is achieved right at the inlet by feeding in
realistic turbulent structures, as applying plug flow conditions requires longer development lengths. Doing
so, three methods for generating turbulence at the inlet are investigated. These are the synthetic eddy
method (SEM), applying periodic boundary conditions, and using a recycling based method.

Synthetic eddy method

Generating turbulence synthetically is nowadays a well embraced technique reaching a fully developed
state as it does not require data libraries or parallel simulations (Dhamankar et al. (2017)). But, this
technique fail when non-correlated structures are generated. This results in too much energy dissipation
and leads to laminarization (Aider, Danet and Lesieur (2007)). This happens because the energy is not
evenly distributed over the energy spectrum.

In the SEM spatially and temporally correlated unsteady fluctuations are generated and superimposed on
an inlet mean velocity field (Jarrin, Benhamadouche, Laurence and Prosser (2006)). In STAR-CCM+ this
method is applied giving in fields of velocity and turbulent intensity at the inlet. However, as eddies must
span at least two cells to produce correlated signals (`0 > 2∆), the minimum mesh-spacing imposes a
limit on this turbulence scale (STAR-CCM+, 2018, p. 3723). Allowing synthetic turbulence to develop to
real turbulence, a sufficient distance should be left to the region of interest. Spurious pressure oscillations
introduced by mass flow fluctuations at the boundary using the SEM are reduced by enabling the ’Mass
Flow Scaling’ option. SEM applied to the geometry is illustrated in Figure 4.7a. Precursor simulations
can provide the required input information. The turbulent intensity (TI) is defined as

I ≡ u′

Ub
=

√
2
3k

Ub
(4.27)
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Figure 4.7: a: Boundary conditions using the synthetic eddy method. b: Boundary conditions applying
periodic boundary conditions.

Periodic boundary conditions

A second method to provide correlated turbulent structures at the inlet is using periodic boundary condi-
tions. This is used when the geometry of interest and expected flow pattern are of a periodically repeating
nature. An example is fully developed pipe flow. By only simulating a short section of the geometry the
fully developed behavior is obtained by copying the flow characteristics from the master to slave bound-
ary plane. Using translational periodicity, enough length should be provided so that the largest coherent
structures in the turbulent flow can still exist. Applying this type of boundary conditions to a geometry
with orifice is presented in Figure 4.7b. Note that when not enough length is provided for the turbulent
flow to return to fully developed pipe flow, either upstream or downstream of the orifice, in essence orifices
are put in series. To drive the flow, either a mass flow rate or pressure drop in axial direction is to be
set.
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Recycling method

The problem of putting orifices in series can be solved using a recycling plane method (RPM). A velocity
field from a downstream location is re-introduced at the inlet (Dhamankar et al. (2017)). In STAR-CCM+
this can be applied by mapping flow characteristics from a short periodic pipe to the inlet of the geometry
of interest, so two simulations are running in parallel. The velocity vector field is mapped from the periodic
outlet to geometry inlet, see Figure 4.8a. This method can be applied to every kind of geometry.
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Figure 4.8: a: Boundary conditions using the recycling plane method. b: Cross correlation of the axial
velocity in the periodic pipe.

Prescribing the periodic pipe mass flow rate is indirectly specifying the bulk velocity. Prescribing the
pressure drop specifies the wall shear stress. It is assumed that specifying mass flow rate is the easiest.
First of all, when considering a pipe with orifice, the pressure drop by the orifice has to be known accurately
upfront to guarantee the right wall shear stress. Secondly, the right mass flow rate specification is preferred
because this is expected to be a dominant factor in the determination of the source term. The mass flow
rate is calculated as

ṁ = ρApUb (4.28)

At the inlet and outlet of the periodic region flow properties are highly correlated. This results in a
normalized two-point cross correlation of one. This correlation is defined as

γij(ri) =
u′i(xi)u

′
j(xi + ri)

(u′2i u
′2
j )1/2

(4.29)

r is the shift of the signal probe location. Turbulent structures can develop when the two-point cross
correlation coefficient between the boundary and half of the pipe length is zero. This is essential because
the large structures are found to be important for generating turbulence at boundaries by Keating, Piomelli,
Balaras and Kaltenbach (2004). They have seen a faster transition using turbulent data from a separate
solution compared to using the SEM. In Figure 4.8b, the cross correlation coefficient of the axial-velocity
component at different locations is depicted for the finest considered computational grid. The reference
signal is at z/D = 0. The cross correlation with itself is obviously one. In the middle of the pipe, the
cross correlation is reaching its final value, i.e. γ will not decrease any further. Therefore, a periodic pipe
length of 3D is sufficient and will be applied in upcoming simulations.

A description of how to implement the recycling plane method in a simulation is elaborated on in Appendix
B.3. The mesh has to be extruded from the inlet. Proposed grids 1 and 4 have a mesh equal to that of the
geometry. With the extrusion method it is also possible to create polyhedral cells with are aligned with
the flow (StevePortal (2019c)). This reduces numerical diffusion (StevePortal (2019a)). This is applied
in grid 5 to 8. The number of extruded layers is determined by dividing the extruded length by the cell
base size. Those values are listed in Table 4.1. Note that by mistake Grid 8 contains too less extruded
layers.
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Pressure outlet

For internal flow it is legit to use a pressure outlet ((STAR-CCM+, 2018, p. 2752)). This is applied in the
geometries with the SEM and recycling plane method at the inlet. The pressure is set to 0 Pa. However,
this value is not important as it does not change the pressure drop from inlet to outlet. When applying a
zero pressure outlet, also fluctuations of pressure at the outlet are forced to zero.

4.5.3 Initialization

LES should be initialized with proper fields to reduce the time to eliminate the effects of the initials. When
mapping converged field data of a coarser grid onto a finer grid, the larger turbulent scales are retained
and the smaller scales can develop quickly. The initial fields are described with velocity and pressure.
Initial turbulence is specified using the SEM.

4.5.4 Data extraction

Data sampling is started when the initial effects are eliminated. This usually takes two to five flow-through
cycles (STAR-CCM+, 2018, p. 3703). With the chosen mass flow rate, flow recirculates roughly four times
per second for a region length of 30D. The initial effects are removed from solutions when velocity, pressure
and TKE are converged in time. This is the case when the mean of flow properties are settling in time.
This is depicted in Figure 4.9 for the axial velocity component, TKE, and pressure respectively.
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Figure 4.9: a: The mean of the axial velocity as a function of time. b: The TKE as a function of time. c:
The mean pressure as a function of time.

The values are probed at the centerline of the pipe at z/D = −5. All the variables are settles after one
physical second, which corresponds to four flow throughs. Settling of the TKE takes more time because
this is a higher order statistic. After converging the data is sampled for another four flow throughs
(STAR-CCM+, 2018, p. 3708). In this thesis the main properties of interest are

• Velocity components.

• Turbulent kinetic energy.

• Turbulent shear stresses.

• Wall shear stresses.

• Static pressures.

• Wall pressure fluctuations.

• Forces on the walls.

To plot cross sectional profiles of velocity, TKE and turbulent shear stresses in radial direction, the data
is averaged in angular direction at angles θ = [0 : 1/8π : 2π]. Line probes are created in radial direction
for every axial location z/D = [−20 : 1 : 10]. The wall shear stresses are sampled with point probes at the
same angular and axial locations on the wall. Wall pressure signals are extracted at every axial location
z/D = [−20 : 1/3 : 10]. The probes are created using JavaScript. The wall force magnitudes are defined
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in axial direction and extracted using a report function. From the description it is not clear how this force
is computed, but it is expected that this is an integral values of wall pressures over an area.

4.6 Analysis of scalability

Performing LES becomes accessible using high-performance computing (Afzal, Ansari, Faizabadi and Ra-
mis (2017)). Practical LES require a short computational time. It is aimed to perform the LES within a
week. The computational time depends on the type and number of processors. The E5 2667 V2 CPU’s
are found to be the best for the simulations. These nodes consist of 16 processors per node. Preferably the
total amount of processors selected is a multiplication of this number. A scalability analysis helps choosing
the right amount of processors. Figure 4.10 illustrates the results of a scalability analysis performed on a
computational grid of 262k cells. The speed up is expressed as the performance of the number of processors
used compared to the performance of 16 processors, see Figure 4.10a. For this coarse grid running LES
with a lot of processors leads to a bad performance, see Figure 4.10b. Performing LES on finer grids results
in a higher efficiency, see Table 4.1. So when increasing the amount of cells, it is beneficial to increase the
amount of processors.
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Figure 4.10: Scalability analysis on a computational grid consisting of 262k cells. a: The speed up as a
function of the number of processors. b: The efficiency as a function of the number of processors.

Table 4.2: The CPU speed up and the efficiency on a computational grid consisting of 262k cells.

No. processors Speed up Efficiency No. cells/processor
16 16 1.00 16347
32 32 0.99 8173
48 38 0.79 5449
64 47 0.74 4087
80 55 0.69 3269
96 58 0.60 2724

4.7 Residuals

The residuals measure the imbalance of the conservation equations and the degree to which their discretized
form is satisfied. Converged solutions are indicated by a minor change of a flow variable from the one
iteration to the next iteration. In transient solutions convergence has the be reached every timestep. The
amount of inner iterations and the under relaxation factor (URF) are used to control this. URFs do
suppress oscillations in the flow that result from numerical errors (Bakker (2002)), see Equation 4.30. On
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the other hand, the under relaxation factors do slow down convergence when chosen too conservative.

φnew,used = φold + URF
(
φnew,predicted − φold

)
(4.30)

The URFs are chosen such that smooth converging residuals are obtained. The amount of inner iterations
is chosen such that the residuals start to flat at the end of each timestep. For the first simulations the
under relaxation factors are 0.7 and 0.3. For the other simulations the under relaxation factors of pressure
is increased to 0.7. Respectively 30 and 20 inner iterations are applied. In Figure 4.11 the residuals of
LES on grid 1 and grid 8 are depicted. Note that both tend to roughly the same residuals. The residuals
of all simulations are listed in Table 4.3.
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Figure 4.11: a: Residuals of LES on computational grid 1. b: Residuals of LES on computational grid 8.

4.8 Summary of simulation details

In Table 4.3 details of the performed simulations are provided. Upcoming results are based on these
simulations.

37



CHAPTER 4. NUMERICAL APPROACH

Table 4.3: Details of the performed simulations.

Run 1 Run 2 Run 3 Run 4
Grid Grid 1 Grid 2 Grid 3 Grid 4

Turbulence RPM RPM RPM RPM
∆t 2.5× 10−5 s 2.5× 10−5 s 2.5× 10−5 s 2.5× 10−5 s

Settling time 1 s 1 s 1 s 1 s
Sampling time 1 s 1 s 1 s 1 s
Inner iterations 30 30 20 20
Velocity URF 0.7 0.7 0.7 0.7
Pressure URF 0.3 0.3 0.7 0.7
Residual con 1× 10−9 8× 10−10 3× 10−10 5× 10−11

Residual x-mom 1× 10−8 8× 10−9 5× 10−9 4× 10−9

Residual y-mom 1× 10−8 8× 10−9 5× 10−9 4× 10−9

Residual z-mom 4× 10−8 3× 10−8 7× 10−9 4× 10−9

CPU’s 96 (16) 96 (16) 96 (16) 96 (16)
CPU time ≈17 h ≈32 h ≈39 h ≈77 h

Run 5 Run 6 Run 7 Run 8
Grid Grid 5 Grid 6 Grid 7 Grid 8

Turbulence RPM RPM RPM RPM
∆t 2.5× 10−5 s 2.5× 10−5 s 2.5× 10−5 s 2.5× 10−5 s

Settling time 1 s 1 s 1 s 1 s
Sampling time 1 s 1 s 1 s 1 s
Inner iterations 20 20 30 20
Velocity URF 0.7 0.7 0.7 0.7
Pressure URF 0.7 0.7 0.7 0.7
Residual con 8× 10−11 3× 10−11 2× 10−11 2× 10−10

Residual x-mom 1× 10−9 3× 10−10 2× 10−10 4× 10−9

Residual y-mom 1× 10−9 5× 10−10 3× 10−10 4× 10−9

Residual z-mom 1× 10−9 3× 10−10 4× 10−10 3× 10−9

CPU’s 96 (16) 96 (16) 96 (16) 96 (16)
CPU time ≈ 27 h ≈ 47 h ≈ 54 h ≈ 137 h
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Chapter 5

Results of Straight Pipe

In this chapter the LES results of the region upstream of the orifice are presented. The results are
divided into two main parts; results based on the application of different boundary conditions and results
based on computational grid refinement. These results are required before results of the orifice region can
be presented. Cross sectional profiles of flow properties will be discussed, wall shear stress results will
be shown, and hydrodynamic pressure fluctuations in straight pipes will be analyzed. Note that some
simulations allow to already include an orifice because it does not influence the results upstream of the
orifice. Additionally, the application of the different boundary conditions has to be done including the
orifice. In the results, the results obtained with LES on computational grid X are shortened as LES X. In
the simulation results, the bulk velocity and TKE are calculated respectively as

Ub =

∫ 2π

0

∫ r
0
uz(r)rdrdθ

πr2
, and kb =

∫ 2π

0

∫ r
0
k(r)rdrdθ

πr2
(5.1)

5.1 Applied boundary conditions

The different boundary conditions are studied with LES on the coarsest grid (grid 1). The following
boundary conditions are applied for that

• Applying the SEM. Velocity input: RANS(k-ε) mean velocity profile, TI input: based on RANS(k-ε)
TKE profile, TLS of ` = 2.0 mm. See Figure C.2 for RANS(k-ε) profiles.

• Applying the SEM. Velocity input: RANS(k-ε) mean velocity profile, TI input: based on RANS(k-ε)
TKE profile, TLS of ` = 2.0 mm. See Figure C.2 for RANS(k-ε) profiles. Implicit LES.

• Applying the SEM. Velocity input: LES mean velocity profile of periodic pipe on Grid 1, TI input:
based on LES mean TKE profile of periodic pipe on Grid 1, TLS of ` = 2.0 mm.

• Applying periodic boundary conditions.

• Applying the recycling plane method.

In here ` is based on the criterion ` > 2∆. Figure 5.1 depicts the velocity and TKE profiles at z/D = 2
normalized with respectively the bulk velocity and bulk velocity squared for the different applied boundary
conditions. None of the velocity profiles is perfect. The centerline values are off and the velocity profiles are
not steep enough close to the wall. The TKE profiles are not correct as well. Peak values are not simulated
appropriately and are shifted from the wall. The wall shear stresses at z/D = −2 are respectively 1.43,
1.45, 1.78, 2.10, 2.12Pa for the different conditions applied. These values are at least 50% off. Lower wall
shear stresses indicate a thicker boundary layer. This explains the shallow velocity profiles close to the
wall and the shifted peak TKE location from the wall compared to the DNS.

The different methods result in different TKE peak values. Applying RANS profiles as input for the SEM,
TKE peak values are low. Additionally, also long lengths are required to develop the TKE profiles. These
development lengths are depicted in Figure 5.2. Additional illustrations are given in Appendix E. In the

39



CHAPTER 5. RESULTS OF STRAIGHT PIPE

0 0.05 0.1 0.15 0.2 0.25 0.3 0.35 0.4 0.45 0.5
0

0.2

0.4

0.6

0.8

1

1.2

1.4

(a)

0 0.05 0.1 0.15 0.2 0.25 0.3 0.35 0.4 0.45 0.5
0

0.002

0.004

0.006

0.008

0.01

0.012

0.014

0.016

0.018

(b)

Figure 5.1: Flow statistic profiles for the different boundary conditions applied as a function of radial
distance to the wall at z/D = −2 compared with DNS. a: The axial velocity normalized with the bulk
velocity. b: The TKE normalized with the bulk velocity squared.

beginning the TKE decreases drastically. This is because the TKE peak location of the RANS profile, see
Figure C.2, does not match the TKE peak location on this grid. Performing implicit LES is expected to
increase the energy in the system as no energy is removed by the SGS model. However, this effect is not
significant. Some LES have shown a significant higher bulk TKE. This difference is not due to numerical
dissipation only.
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Figure 5.2: The development of quantities as a function of upstream distance to the inlet. a: The centerline
velocity in axial direction normalized with the bulk velocity. b: The bulk TKE normalized with bulk
velocity squared.

Regarding Figure 5.1b, applying the other proposed boundary conditions shows better simulated TKE
peak values. Using the SEM applied with boundary conditions obtained from a precursor LES gives better
results than before. Applying periodic boundary conditions results in proper profiles as well. But, with
periodic boundary conditions profiles of stronger turbulent flow are applied at the inlet, see Figure 5.2b.
This is because an orifice is included. If insufficient distance is provided, the flow does not return to
pipe flow conditions. The TKE peak values are higher, but at the centerline the TKE is still insufficient.
Besides, this method requires a precursor LES which is undesirable. The recycling plane method shows
the best results.

The recycling plane method and using periodic boundary conditions are the easiest to implement. However,
when applying periodic boundary conditions higher pressure fluctuations are seen in the whole domain,
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see Figure 5.3. This is nonphysical because no significant hydrodynamic pressure fluctuations should be
present upstream of the orifice. These higher pressure fluctuations are coupled in the CFD solver with the
high velocity fluctuations at the inlet, see Figures 5.2b. The pressure fluctuations decay linearly from the
inlet whereas the velocity fluctuations decay exponentially. Note that when using the SEM, the mass flow
scaling specification option should be enabled as fluctuations in mass flow rate cause pressure fluctuations
using incompressible solvers, see Figure 5.3a. All in all, specifying inlet turbulence with the recycling plane
method is the most favorable method for LES on coarse computational grids with an orifice.
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Figure 5.3: a: Wall pressure fluctuations normalized with the hydrodynamic pressure. b: The PSD of wall
pressure fluctuations in a straight pipe.

Applying the RPM, lower wall pressure fluctuations exist in the extruded part of the domain, see Figure
5.3a This 3D domain is obviously not influenced by the orifice which explains the lower wall pressure
fluctuations. Van de Meerendonk (ASML (2020)) performed wall pressure measurements in straight pipes,
see Section 3.3. Power spectra of wall pressure fluctuations just upstream of the outlet are compared
with these experiments in Figure 5.3b. Results are obtained applying the SEM to the coarsest and finest
computational grid. Results are not normalized because the mean wall shear stresses are significantly
different.

In the frequency range from 50 to 500 Hz, LES on the finest computational grid compares well with
experimental data. For higher frequencies, the content starts to deviate significantly from the measurement
data. However, at this frequency the measurements include background noise and is therefore not reliable
for higher frequencies. LES on the coarsest computational grid shows better results till a frequency of
100 Hz. At higher frequencies the LES deviates from the measurement and LES spectrum on the finest
grid. According to Wagner et al. (2007) this might be indicative of a lack of spatial resolution which is
manifested by an underpredicted power level. This is because energy contained by the unresolved eddy
structures is lost in the SGS which explains the bad resolution at higher frequencies.

5.2 Computational grid refinement

Mainly LES results on grid 1 were regarded previously. This coarse grid has cell sizes larger than the Taylor
microscales. Therefore, it should definitely be possible to obtain better simulations results by refining the
computational grid. From now on only the recycling plane method will be applied for this refinement, for
reasons mentioned in the previous section. The results of the refinement study will be compared with the
DNS results of El Khoury et al. (2013). The velocity profiles at z/D = −2 are depicted in Figure 5.4 for
the computational grids proposed in Table 4.1. LES on coarser grids result in shallow velocity slopes in
the boundary layer. For finer grids the velocity slope steepens as illustrated in Figure 5.4a. However, the
solution on the finest grid does not results a better velocity profile at the centerline. In Figure 5.4b the
velocity profiles are normalized with the friction velocity. In the viscous sublayer (1 < y+ < 5) the velocity
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Figure 5.4: Velocity profiles in the axial direction at z/D = −2 for LES on different grids. a: Normalized
with the bulk velocity. b: Normalized with the friction velocity.

is resolved or modelled with a reasonable accuracy. But, the solutions on the finer grids are significantly
better. In the buffer layer (5 < y+ < 30) the velocity profile starts to deviate from the DNS. This starts
when the velocity profiles start to deviate from being approximately linear (u+ = y+). Further from the
wall it should adopt the logarithmic representation of the profile. Refining the grid, the velocity gradually
moves to the DNS solution in the logarithmic region. This behavior is coupled with the simulated wall
shear stress. These wall shear stresses are significantly different for the LES on the analyzed computational
grids.
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Figure 5.5: TKE profiles at z/D = −2 for LES on different grids, see Table 4.3. Results are compared
with DNS of El Khoury et al. (2013). a: Normalized with the bulk velocity squared. b: Normalized with
the friction velocity squared (see legend of others).

The TKE profiles are compared in Figure 5.5. The TKE peak values normalized with the bulk velocity
squared tends to the right value for LES on finer grids, see Figure 5.5a. Additionally, the peak shifts to
the right location closer to the wall. The TKE normalized with the friction velocity squared is illustrated
in Figure 5.5b. The TKE is more accurately resolved and modelled in the whole inner and outer layer for
LES on finer grids. A main contribution to this is the simulated wall shear stress, affecting the friction
velocity, see Equation 3.6. The turbulent wall shear stress are compared with DNS in Figure 5.6. The total
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shear stress in fluids is given in Equation 2.24. Den Toonder and Nieuwstadt (1997) mentioned that

τ+T + τ+v = 2
r

D
(5.2)

The solutions tend to this straight line as seen in Figure 5.6a. In Figure 5.6b it is shown that the turbulent
shear stress is better resolved with LES on finer grids. This is again affected by wall shear stress which
will be elaborated on later.
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Figure 5.6: Turbulent shear stress profiles at z/D = −2 for LES on different grids. a: Normalized with
the friction velocity squared. b: Normalized with the friction velocity squared on logarithmic x-axis (see
legend of others).

The development of the bulk velocity and centerline velocity in axial direction normalized with the bulk
velocity as a function of distance to the orifice are illustrated in Figure E.2. Both are stabalizing in the
provided 20D upstream for all used computational grids. In Figure E.3 the development of the bulk and
peak TKE normalized with the bulk velocity squared is depicted as a function of distance to the orifice.
Downstream of the first 3D, both show a decrease in TKE. The TKE values on the different computational
grids then recover and stabilize within the provided 20D. The TKE needs more distance to settle compared
to the velocity, which is a lower order statistic.

5.3 Wall shear stress

As mentioned before, there is a significant deviation in simulated wall shear stresses using the different
computational grids. The wall shear stresses and grid parameters that might affect the wall shear stress
are tabulated in Table 5.1.

Table 5.1: The simulated wall shear stress and the computational grid properties.

Grid 1 Grid 2 Grid 3 Grid 4 Grid 5 Grid 6 Grid 7 Grid 8
τw [Pa] 2.12 2.60 2.42 3.16 3.62 3.19 2.97 4.02

Cell size (CS) [mm] 0.86 0.63 0.63 0.43 0.42 0.41 0.42 0.27
No. prism layers 10 12 25 25 5 12 8 10

δ+p 49 49 49 49 70 70 70 49
SF 1.5 1.5 1.3 1.3 1.2 1.2 1.5 1.1
y1

+ 0.22 0.10 0.04 0.04 4.70 0.84 0.71 1.54
δp,last/CS 0.27 0.37 0.26 0.37 0.66 0.45 0.83 0.43
CSlast/CS 0.66 0.72 0.64 0.74 0.85 0.77 0.95 0.79

The total prism layer thickness does not seem to have a direct effect on τw. Neither does the y+-value.
However, τw increases with a decrease in cell size in the bulk region and cell size of the last prism layer. The
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fraction of both, which represents the smoothness in cell size between the bulk region and near wall region,
also shows a strong correlation with the wall shear stress. This is all depicted in Figure E.4. However,
some computational grids diverge from this trend. This is the case for the grid with a base size of 0.35mm
and 8 prism layers. This is explained by its high stretching factor compared to the other meshes with a
base size of 0.35mm. Therefore the fraction of the cell sizes and stretching factor are divided with the
stretching factor. Figure 5.7a illustrates a trend of increasing wall shear stress by decreasing the stretching
factor and ratio of cell sizes. Additionally, in general the cell size has to be decreased.
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Figure 5.7: a: The wall shear stress as function of different computational grid properties. b: The wall
shear stress development as a function of upstream distance to the inlet.

The development of the wall shear stress as a function of upstream distance to orifice is illustrated in
Figure 5.7b. Note that in some simulations the wall shear stress is extracted zero because the pipe wall of
the extruded part which is just a setup mistake. In general the wall shear stress settles very fast applying
the recycling plane method. However, some simulations show a lower wall shear stress in the extruded
part, which is not expected using the recycling plane method. The LES which are extruded without
remeshing (grid 5 to grid 8) are showing this. This is in contrast with the conclusions in Section 4.5.2.
Having extruded cells was namely expected to be better. So the transition in cell structure explain the
different predicted wall shear stress. The choice not to change the cell size locally around the orifice is
thus strengthened.

Grid 8 does not contain the right amount of extruded layers in stream wise direction, see 4.1. Comparing
with a LES of a straight pipe extruded with the right number of layers (135 cells), a better match in wall
shear stress is simulated, see Figure 5.7b. The wall shear stress of the dashed line is higher in the extruded
part. This emphasizes the importance of applying correct cell shapes again in LES. Despite that, both wall
shear stress lines match for sufficient distance from the inlet. It is concluded that extrusion in combination
with remeshing works better for providing information to inlet of the region of interest.

5.4 Conclusions

In the previous study flow characteristics in turbulent pipe flow have been analyzed. The results of this
analysis are taken into account for analyzing the turbulent flow around and orifice using practical LES.
The results of this study are treated in the following chapter. The main conclusions from the straight pipe
analysis are

• Inlet profiles should be applied which are close to the expected profiles in turbulent pipe flow on that
grid when applying the SEM on coarse grids.

• The recycling plane method performs best in terms of development length and flow statistics and is
therefore used for further analysis.

• The LES on the finest grid shows a good agreement with the experimental data of wall pressure
fluctuations for turbulent flow in straight pipes.
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• The flow characteristics simulated with LES on the finest grid compares best with DNS.

• Remeshing the extruded part results in a better prediction of the wall shear stress in straight pipes.
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Chapter 6

Results of Orifice

In this chapter LES results turbulent flow through pipes with an orifice are presented. The recycling
plane method will be used at the inlet and the same computational grids will be applied as in Chapter
5. First the velocity fluctuations will be studied and compared with DNS. Afterwards, the static pressure
drop and mean force on the plate are studied. The static pressure drop will be compared with values
found in literature. Also the fluctuating pressure drop and fluctuating force on the plate are analyzed.
Additionally, the accuracy of the simulations will be analyzed. This will be done based on different
value criteria and comparing the data with experimental data and DNS. In this chapter always the gauge
pressure is considered, which is the difference between the total pressure and atmospheric pressure. Besides,
a simulation performed with LES on computational grid 8 is abbreviated with LES 8.

6.1 Velocity fluctuations

The frequency content of velocity fluctuations in the domain is studied computing the one-dimensional
energy spectrum. One-dimensional energy spectra are computed by generating the PSD of velocity signals
in axial direction. Results will be compared with DNS data of turbulent channel flow at Re = 10000 by
Lee and Moser (2015) extracted from a turbulence database. It is assumed that the energy content at
the centerline of pipe and channel flow are equal for similar turbulent levels. This data is provided as
a function of the wave number, κ. According to Taylor’s hypothesis Taylor (1938), power spectra and

frequency are related as E(f̂) = E(κ)2π/Ub because f̂ = κUb/(2π). This assumption of frozen turbulence
thus allows to interpret measured time series at a single point as spatial variations. As done by Lee and
Moser (2015), energy spectra of LES and DNS are normalized respectively as

Φ∗vv(f) =
fEzz(f)

U2
b

, and Φ∗vv(f̂) =
f̂Ezz(f̂)

U2
b

(6.1)

Note that the spectra are normalized with the bulk velocity of the pipe. When normalizing the spectra
with the friction velocity, a distorted view is expected between the spectra of the different results. In
Figure 6.1 the one-dimensional velocity spectra are compared with DNS for axial locations z/D = −5, 0, 5
and 10. Kolmogorov (1941) has shown that for isotropic hydrodynamic turbulence, the inertial subrange
of an one-dimensional energy spectrum scales as Φvv ∝ f−5/3. This slope is included in the following
figures.

In Figure 6.1a the upstream velocity spectrum, at z/D = −5, simulated on the finest grid matches with the
slope for isotropic turbulence. Additionally, results on that grid are in accordance with the DNS for a wider
frequency range. Velocity spectra on computational grids with the same grid size coincide at frequencies
above 100 Hz. This indicates a strong grid dependency. The area under the graphs increases as a function
of decreasing grid sizes. It is concluded that in the straight pipe region a larger part of the flow is resolved
when performing LES on finer grids. Besides, LES 8 shows a slope of f−5/3 in the inertial subrange, so
this range is properly resolved in the straight pipe region. Every LES shows a particular frequency at
which the energy content starts to deviate from DNS. This effect is attributed to dispersion as content is
shifted to higher frequencies. The occurrence of this numerical noise starts at lower frequencies for coarser
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Figure 6.1: The normalized one-dimensional velocity spectra in flow direction obtained with LES on
different grids compared with DNS (Lee and Moser (2015)). Data is probed at the centerline at different
axial locations; a: z/D = −5, b: , c: , and d: .

grids and at higher frequency if finer grids. This is due to the grid frequency a computational grid can
represent.

Inside the orifice, at z/D = 0, the turbulent flow strongly deviates from isotropic turbulence, see Figure
6.1b. The content of the velocity fluctuations is decreased in the lower frequency range and is increased
in the higher frequency range compared to z/D = −5. This implies that larger turbulent structures
are not entering the orifice. However, smaller turbulent structures are forming and dominate the energy
spectrum at higher frequencies. The energy spectrum simulated on grid 5 strongly deviates from the other
results. This might be related to the very poor resolution in the orifice region, see Figure D.1. The peaks
around 1000 Hz may be introduced by the orifice. However, no general peak frequency can be designated.
At higher frequencies the decay is high. Note that no dominant numerical errors are visible at higher
frequencies. This is likely because content is higher than the error itself. Besides, the grid frequency is
higher which may result in errors at higher frequencies only.

Downstream of the orifice, at z/D = 5, the energy content is large for all frequencies, see Figures 6.1c.
Moving in flow direction, at z/D = 10, the energy spectrum shows that the flow returns to isotropic
turbulent flow, see Figure 6.1d. The f−5/3-trend is recognized again for the energy spectrum by LES 8.
Additionally, computational grids with similar cell sizes cause results to merge and the content over the
whole frequency range drops.
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6.2 Pressure drop

Table 6.1: Pressure and force data by LES on different computational grids.

Grid 1 Grid 2 Grid 3 Grid 4 Grid 5 Grid 6 Grid 7 Grid 8

∆p [bar] 0.236 0.239 0.239 0.242 0.169 0.257 0.252 0.241
∆prms [Pa] 732.4 732.3 738.4 720.2 345.4 248.9 281.6 571.9
F total [N] 1.483 1.514 1.510 1.535 1.070 1.631 1.601 1.532
ζ1 [%] 1.023 0.532 0.538 0.270 0.305 0.102 0.217 0.045

Ft,rms [mN] 46.0 46.0 46.0 45.7 21.4 15.1 17.6 35.6
ζ2 [%] 0.042 0.038 0.038 0.009 0.052 0.044 0.020 0.052

The pressure drop induced by an orifice is significantly larger than the pressure drop in a straight pipe.
Including an orifice with an area ratio of 20% and a thickness of t/Dh = 0.5 should result ,with the
chosen mass flow rate, in a pressure drop of ∆p = 0.260 bar (Idelchik (1986); Tullis (1989)). The mean
wall pressure as a function of normalized distance to the orifice is depicted in Figure 6.2. In here also a
schematic of the point probe locations around the orifice is added. Note that the pressure goes to 0 Pa
because a zero pressure boundary is applied at the outlet in LES. The difference between the maximal and
total permanent pressure drop is clearly visible.
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Figure 6.2: Mean wall pressure as a function of normalized distance to the orifice for LES on different
computational grids. A schematic of distribution of wall point probes is included.

The total permanent pressure drop of all LES is tabulated in Table 6.1. All LES show a pressure drop
around ∆p = 0.25 bar which are close to the value in literature, except for grid 5. The root mean square
values of the pressure drop fluctuations between the inlet and outlet are tabularized in Table 6.1. In
contrast with the mean pressure drop values, the fluctuations of the pressure drop show a significant
spread.

6.3 Pressure fluctuations

Despite that pressure waves cannot radiate in incompressible CFD simulations, the wall pressure fluctu-
ations in the jet-wake region can be compared with the measured pressure fluctuations. Hydrodynamic
pressure fluctuations are measured by Anantharaman (2014) and Kottapalli. Data of Anantharaman only
ranges till a frequency of 800 Hz. Therefore, Equation 3.3 is applied to specify the frequency range for the
prms calculation. This guarantees a fair comparison between experimental data and LES. Integrals are
evaluated over a frequency range from 10 Hz to 800 Hz so significant pump behavior is disregarded, see
Figure 3.2. The normalized wall pressure fluctuations as a function of normalized distance to the orifice
are depicted in Figure 6.3. LES on all grids and both experiments are included.

No pressure fluctuations are seen at z/D = 10 because in LES a zero pressure boundary is applied at
the outlet. Additionally, 2D upstream of the outlet no large pressure fluctuations are found because
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Figure 6.3: Normalized wall pressure fluctuations obtained with LES on different computational grids as
a function of normalized distance to the orifice. A frequency range from 10 Hz to 800 Hz is considered. A
schematic of the distribution of wall point probes is included.

acoustic waves do not radiate in incompressible LES. Therefore, there LES and experiments are not
directly compared. The LES pressure fluctuation just upstream and downstream of the orifice are roughly
equal. In the jet-wake region, at z/D = 1, both LES and experiments compare well. At z/D = 2 and
z/D = 3 refining the computational grid leads to a better comparison with the experiments. However, as
the experimental data obtained at the TU/e is expected to contain the least noise, the LES wall pressure
fluctuations are over predicted. Unfortunately the experimental data does not provide additional resolution
at z/D = 1.5 as Agarwal (1994b) has measured a peak in pressure fluctuations of air flow through an orifice
between z/D = 1 and z/D = 2. At z/D = 6 the acoustic content in the experiments declares the difference
between LES and experiments.

On the middle surface of the orifice, at z/D = 0, significant pressure fluctuations are simulated, see Figure
6.3. At that location flow separation occurs which is expected to give, in combination with reattachment,
high pressure fluctuations (Anantharaman (2014)). No pressure transducer is included in the experiments
at that location. However, as the pressure fluctuations are coupled with the fluctuations in velocity, shear
stress components at that location can be regarded. In Figure 6.11a, τxx and τzz show larger fluctuations in
velocity at the orifice compared to the dead zone close to the wall. PIV results performed by Anantharaman
(2014) confirm the velocity fluctuations around the orifice, see Figure 6.11b. Additionally, higher velocity
fluctuations are expected because of an increase in Reynolds number in the orifice hole. This indicates that
the large hydrodynamic pressure fluctuations at the orifice at z/D = 0 are physical. Regarding the PIV
results in Figure 6.11b, hydrodynamic pressure fluctuations simulated with LES 6 and 7 are expected to
be inaccurate. Upstream of the orifice wall pressure fluctuations out of LES cannot be directly compared
with the experimental data. But, it is remarkable that the wall pressure fluctuations are high and constant
as a function of axial distance to the orifice. This behavior will be explained later.

Besides the average value of pressure fluctuations, the pressure content as a function of frequency gives in
the LES results. The wall pressure spectra simulated with LES at z/D = 1, 2, 3 and 6 downstream of the
orifice are depicted in Figure 6.4. Pressure spectra obtained with experiments by Kottapalli are added.
The slope of the measured pressure spectra is included in the figures. Acoustic noise is neglected.

At z/D = 1 the pressure content of the LES deviates within one order of magnitude at frequencies till 500
Hz, see Figure 6.4a. The shape of the PSDs match with the experimental pressure spectrum, but no clear
trend is seen. At higher frequencies, the spectra start to decay. The slope is simulated steeper with LES
for coarser grids. Neglecting the acoustic content, the slope of LES 8 matches best with the experiments.
The slopes by the other LES are too steep. At z/D = 2 content at lower frequencies is more stable as a
function of frequency, see Figure 6.4b. LES on coarser grids show a higher content and is decreasing for
LES on finer grids. At 300 Hz the content starts to decrease. The decay of LES 8 again matches best with
experimental data. The others are again steeper.

At z/D = 3, the acoustic pressure fluctuations become dominant over the hydrodynamic pressure fluctu-
ations already at a frequency of 300 Hz. Regarding Figure 6.4c and neglecting the acoustics, the content
and slope of LES 8 are the best comparing with the experimental data. The content at lower frequencies
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(d) z/D = 6.

Figure 6.4: The wall pressure spectra obtained with LES on all computational grids. The slope of the
experimental data obtained by Kottapalli is included. Data is probed at different axial locations.

decreases when refining the grid, as seen before. Further downstream, at z/D = 6, the acoustics are very
dominant, see Figure 6.4d. Remarkably the LES on coarser meshes simulate a better slope compared to
the fine simulations. Additionally, strange fluctuations are found for the LES on grid 5 to 8. LES 1 and
2 are performed with a lower pressure under-relaxation factor. This might result in a better monotonic
stabilization of the residuals. Dispersive errors, characteristic of second-order upwind schemes, can pro-
duce non monotonic residuals and smear results less. Because of the increased pressure under-relaxation
factor, residuals are not perfectly flattening in a monotonic way, see Figure 4.11. This might introduce
dispersive errors which are especially dominant in the higher frequency range where pressure content is
small. However, it is more likely that it is a grid dependent phenomenon. Grids 6 to 8 have a thinner prism
layer around the orifice, see Section 4.4.3. This change maybe leads to errors or the capture of a physical
behavior. Nonetheless, the observed pressure fluctuations are assumed not to affect the force spectrum
because the magnitudes are low. So from the comparison with pressure fluctuations in the jet-wake region
with experimental data, LES 8 shows best results in terms of prms values and slopes of decay.

The obtained LES pressure spectra are compared with power laws, as suggested by Kottapalli (2020). They
mentioned that in homogeneous isotropic turbulence, the inertial subrange of power spectra typically shows
a power law of f−7/3 resulting from a turbulence-turbulence interaction (Hill and Wilczak (1995); Zhao,
Cheng, Qiu, Burnett and Liu (2016)). Isotropic conditions do only apply in shear free flow. At locations
close to the orifice, shear stresses play a major role, as will be shown later in Figure 6.11. George, Beuther
and Arndt (1984) found that pressure spectra decay as f−11/3 when dominated by shear stress-turbulence
interactions. With that, the decay of a pressure spectrum in the inertial subrange as a function of frequency
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for sufficiently high turbulence is superposed as

Φpp(f) = Φs(f) + Φt(f) , Φs(f) ∝ f−11/3 , Φt(f) ∝ f−7/3 (6.2)

Tsuji and Kaneda (2012) have shown that this suggestion also holds for anisotropic wall bounded shear
flows. Pressure spectra of wall pressure fluctuations at different location downstream of the orifice are
depicted in Figure 6.5 for respectively LES 4 and LES 8.
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(b) LES on computational grid 8.

Figure 6.5: Wall pressure spectra obtained with LES at locations z/D = 1 till z/D = 6. Power laws Φs(f)
and Φt(f) are included.

At z/D = 1 and z/D = 2, where the shear stresses are the highest, the PSDs agree with f−11/3 indicating
shear stress-turbulence interaction. Further downstream, the slope of the PSDs decrease. At those loca-
tions, a significant frequency range agrees with f−7/3 indicating turbulence-turbulence interaction. Note
again that LES 8 shows higher frequency content at higher frequencies possibly due to dispersion. All in
all the resulting pressure spectra are concluded to be in well agreement with the power laws, as also found
for the presented experimental results obtained by Kottapalli at TU/e.

Although comparison with experimental data is not legit for pressure fluctuations upstream of the orifice
because of the dominance of acoustic noise, the characteristics of the flow give insight. As already seen in
Figure 6.1 and in Chapter 5, the one-dimensional energy spectrum upstream of the orifice and the cross
sectional flow statistics meet the characteristics of turbulent pipe flow. Additionally, the pressure spectrum
is according to Φpp ∝ f−7/3 in the inertial subrange for homogeneous isotropic turbulence.

Pressure spectra inside the orifice, at z/D = 0, and upstream of the orifice, at z/D = −2, are depicted
in Figure 6.6. Inside the orifice sharp peaks are seen in the power spectra for every LES. As these peaks
are not appearing at a similar frequency for every grid simulated on for a constant mass flow rate, it is
thought that these peaks are nonphysical. Note that the peaks of LES 1 to 4 are roughly the same, whereas
the other LES show very different behavior. Additionally, note that the extruded region of the first four
grids is remeshed. This might lead to a smoother transition from extruded part to the region of interest
which consequently might result in less introduced numerical pressure fluctuations. The frequencies at
which the peak occurs scales with the grid size for grids 1, 3, 6 and 8. However, not every grids follows
this trend. With this in mind, two main decay rates are found for every simulation: one including the
peak and one excluding the peak. For LES 8 these are f−3 and f−12 as depicted in Figure 6.6a. The
first slope is considered physical, whereas the latter slope is expected to be nonphysical because it is very
high compared to the presented power laws of pressure spectra. Regarding the locations upstream of the
orifice, all pressure spectra are similar to those inside the orifice, see Figure 6.6. The shapes are roughly the
same showing similar peak-frequencies and decay rates. However, the values are generally lower. Because
an orifice is a very strong disturbing source acting as a low-pass filter, the pressure spectra upstream of
the orifice are resulting from this. As incompressible LES is performed, the pressure spectra are similar
everywhere upstream of the orifice. This explains why the pressure spectra are different compared to the
pressure spectrum in straight pipe flow.
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(b) z/D = −2.

Figure 6.6: Wall pressure spectra obtained with LES on all computational grids.

To investigate if a high-frequency phenomenon can be attributed to the pressure spectra peaks, snapshots
of the velocity field simulated with LES on computational grid 8 are studied. After counting the amount
of vortex rings that have been shed in a time span of 0.06 physical seconds, a shedding frequency of
f ≈ 1000Hz is found. This corresponds to a nondimensionalized frequency of St ≈ 0.37 which is in line
with a Strouhal number range St ≈ 0.2-0.4 found in literature. But, this frequency does not match the
frequency of the peak simulated with LES on grid 8. Snapshots of the field are illustrated in Figure 6.7.
Note that the snapshots are taken with the vortex ring visible at roughly z/D = 1.
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Figure 6.7: Snapshots of the velocity magnitude field at different time instants obtained with LES on the
finest computational grid.

6.4 Source term

The source term is found to be a fluctuating force in Chapter 2. In LES the forces on the pipe wall, orifice
up- and downstream facing surface and orifice middle surface are coupled with the pressure fluctuations
in the system. The power spectra of these fluctuating forces simulated on the coarsest and finest grid are
depicted in Figure 6.8a.

The up- and downstream facing surfaces of the orifice are showing the largest force fluctuations. These
surfaces are exposed to most fluid inertia as these surfaces are perpendicular to the flow. It is seen in
Figure 6.8a that the fluctuations on the upstream orifice surface are higher. A reason for this might be
the increased pressure fluctuations upstream of the orifice introduced by the orifice itself. The fluctuating
forces on the other two surfaces are resulting from wall shear stresses. The fluctuations on the pipe wall
are seen to be submissive to the fluctuating forces on the orifice plate. So possible wall shear stresses by
the jet have no significant effect on the force fluctuations via the pipe wall. Besides, this fluctuating force
is a function of the domain length and is therefore disregarded in the determination of the source term.
Note that it still plays a role in the momentum balance.

The summation of mean forces on the orifice surfaces is listed in Table 6.1 for the different LES. As the
orifice stagnates the flow and creates a pressure drop, both the mean force and the pressure drop are
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Figure 6.8: a: Force spectra on the different geometry surfaces simulated on the coarsest and finest grid
using LES. b: Net force spectra on the orifice plate for different LES.

compared by calculating the normalized difference between the two as

ζ1 =
∆p− F total

Ap

∆p
· 100% , ζ2 =

∆prms − Ft,rms

Ap

∆prms
· 100% (6.3)

For the different considered computational grids, these values are listed in Table 6.1 as well. The normalized
difference between the two is 1% or lower. These values therefore indicate that the mean pressure drop is
directly coupled with the mean total force in the system divided by the cross sectional pipe area, Ap.

The force spectra of the total fluctuating force on the orifice plate are depicted for all LES in Figure
6.8b. Roughly speaking, most spectra show a constant content at higher frequencies and starts to decay
at a particular frequency. A peak is present in almost all spectra as is found for the pressure spectra at
z/D ≤ 0. The force spectra therefore also show to slopes which are visualized in Figure 6.8b for LES 8.
The decay rates are again f−3 and f−12. No direct comparison with measurements is possible for ΦFF ,
but it is likely that the spectra are coupled with the pressure spectra and therefore a slope of f−12 is again
considered high. In contrast to this, the slope f−3 is very close to the proposed scaling ΦFF ∝ f−3.2 by
Moussou (2006).

Root mean square values of the total force on the orifice plate, Ft,rms, are added to Table 6.1. Note that
these values are obtained by taking the rms of the resultant total force signal in time, so all frequencies are
included. Note that disregarding the force fluctuation on the pipe wall has a minor effect on the momentum
balance. A large deviation in Ft,rms-values is found for the LES on the different computational grids. As
was the case for the mean values, the fluctuating pressure drop times pipe area and the fluctuating force
are related. The normalized differences between the two are calculated with ζ2, see Equation 6.3, and also
added to Table 6.1. Both are in balance with an error smaller than 0.1%.

To understand the similarity between force and pressure differences, the momentum equation (Equation
2.2) is rewritten in integral form, as done in the book by J. Anderson (2016), as

∂

∂t

∫∫∫
V

ρuidV +

∫∫
S

(ρuidS)ui = −
∫∫

pdS − Fi (6.4)

Note that viscous effects are neglected as these scale with 1/Re. The problem is regarded as an interaction
between a control volume inside the geometry and the geometry itself as depicted in Figure 6.9. p is the
pressure to the body and F is the reaction force of the body to the fluid.

In Equation 6.4 the derivative w.r.t. time drops out as a constant mass flow rate is applied at the inlet
boundary in LES and therefore the mass flux is constant. Note that incompressible LES are performed
so the density is constant. The second term represents the mass flux over an area times the velocity, or
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Figure 6.9: Control volume of the fluid in the domain.

momentum flux. The average mass flux at the inlet and outlet of the control volume are equal as well.
However, the momentum flux deviates dependent on the location of the in- and outlet of the control volume
as the velocity profile might be different. If the boundaries are taken far enough up and downstream, the
velocity profiles are equal to that of turbulent pipe flow and the convective term is of no influence on
the momentum balance. The boundaries of the control volume are the inlet and outlet boundary as the
pressure drop is compared with. Therefore, the momentum equation only contains surface forces and
reduces to

Fi = −
∫∫

pdS (6.5)

The difference in sign is explained from the fact that the pressure drops in positive direction. The small
difference indication parameters ζ1 and ζ2 imply that momentum is conserved in the performed LES. Note
that the contribution of the convective term can be determined by using the cross sectional profiles of
pressure and velocity. Based on Figure 6.3 it can already be concluded that the convective terms has a
contribution when the downstream control volume boundary is within the jet. Namely, then the fluctuating
pressure drop in downstream direction is positive.

To study the correctness of the plateau of the PSDs, i.e. to analyze the values ∆prms and Ft,rms, different
control volumes need to be analyzed. Because the pressure is very diffusive, this value is for now assumed
to be constant over a cross section in cross stream direction. Then, when regarding Figure 6.3, already
the effect of choosing the downstream boundary inside the jet region can be judged. The ∆prms will be
positive in streamwise direction in that case. Therefore, the fluctuations in the convective term will be
significant. This requires an additional investigation including the right profiles which can be obtained
from the performed simulations. But, it is expected that the Ft,rms-value will be affected by the slightly
overpredicted pressure fluctuation in the jet-wake region.

All in all, the high pressure fluctuations upstream of the orifice are a direct result of the fluctuating force
by the orifice to the fluid. The high pressure fluctuations are located upstream of the orifice because a
zero pressure outlet is applied. If the inlet is chosen to be a zero pressure inlet and the outlet is chosen to
be a mass flow outlet, the result will be equal, but the high pressure fluctuations are build up downstream
of the orifice.

6.5 Orifice resolution

Besides the resolution of flow in the straight pipe region treated in Chapter 5, the orifice and jet-wake
region have to be resolved with an acceptable accuracy. A well resolved solution in this region requires
finer computational grids. This is shown in Figure C.3 regarding the Taylor micro scales. In Section 4.2.4
a method to judge accuracy is proposed comparing the subgrid kinetic energy to TKE (MTKE) and the
turbulent viscosity ratio (TV R). Maximum LES field values of these parameters are tabulated in Table
6.2. As around the orifice one single cell gives very high values for the TV R, the listed values are based on
maxima in the jet-wake region. For the MTKE , the cells adjacent to the wall are not taken into account as
these are always one because of pure modelling. The turbulent viscosity ratio decreases linearly with cell
size refinement. µT accounts for the stress effects of the smaller underresolved eddies on the larger resolved
scales. A small µT -value indicates that a larger proportion is directly resolved for. Please note that the
total simulated fluid stresses are not necessarily different. So, in line with expectations, a larger proportion
of scales is resolved using LES on finer computational grids. For LES TV R = 10 is considered sufficiently
low. The TV R-field simulated with LES 8 is depicted in Figure 6.10a. Most of the values in the jet-wake
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region are around TV R = 15. Far up- and downstream of the orifice these values are TV R < 2 for all
LES. Therefore, it is concluded that the pipe region is properly resolved whereas the jet-wake regions are
simulated with an insufficient accuracy. Nonetheless, the TV R on grid 8 is acceptable.

Table 6.2: Values for the turbulent viscosity ratio (TV R = µT /µ) and the subgrid kinetic energy to TKE
ratio (MTKE = kSGS/(kSGS + kres) simulated with LES on different computational grids.

Grid 1 Grid 2 Grid 3 Grid 4 Grid 5 Grid 6 Grid 7 Grid 8
TV R 104.9 73.65 77.88 52.33 55.06 56.56 52.79 24.94
MTKE 0.980 0.973 0.977 0.967 0.966 0.963 0.963 0.895

The listed maximum values for MTKE are large compared to the criterion MTKE = 0.2, see Table 6.2.
Most TKE is modelled just upstream of the orifice, see Figure 6.10b. This is explained by `0 being smallest
upstream of the orifice, see Figure 6.10c. In contradiction with TV R, decreasing cell size does not lead
to a significant decrease in the modelled TKE. In the pipe region and jet-wake region, MTKE-values are
acceptable for all performed simulations.

Based on MTKE , in some regions large proportions of the velocity fluctuations are not resolved. Via the
velocity-pressure coupling, this would mean that the pressure fluctuating field is also simulated poorly as
well. So if only the velocity fluctuations just upstream of the orifice hole determine the prms-field, this
would lead to poor representations of the prms-field. However, as the TKE is a minor fraction of the TKE
downstream of the orifice, this is not a problem.

(a) (b)

(c) (d)

Figure 6.10: Results of LES performed on grid 8. a: The mean of the turbulent viscosity ratio, TV R.
b: The TKE by the sugrid scale model to the resolved TKE, MTKE . 6.10c: The mean of the turbulent
length scale, ¯̀

0. d: The instantaneous turbulent time scale, t`.

Time-averaged turbulent length scales are small just around the orifice as depicted in Figure 6.10c. ¯̀
0 is

already smaller than the filter width at some locations, let alone the smaller Taylor microscales. Therefore
the cell sizes have to be reduced around the orifice, assuming that the presented length scales are simulated
correctly. A snapshot of the instantaneous turbulent time scale, t`, shows that the chosen time step
∆t = 2.5× 10−5 s is small enough, see Figure 6.10d.

The flow field statistics obtained with LES are compared with 2D-PIV performed by Anantharaman
(2014) (Re ≈ 10500) in Figure 6.11. The fields are shown just downstream of the orifice till z/D ≈ 4.
The top figures compare mean velocity magnitude normalized with bulk velocity, which show a good
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(a) LES (b) PIV

Figure 6.11: The field visualization of the mean velocity and the cross stream and axial fluid stresses
normalized with respectively the friction velocity and friction velocity squared, and the static pressure
gradient. a: LES on the finest grid (Re = 10000). b: PIV by Anantharaman (2014) (Re ≈ 10500).

comparison. In the middle figures, fluid shear stresses in respectively rr-direction, zz-direction, and xz-
direction normalized with bulk velocity squared are compared. The field shapes are similar, but LES
simulates slightly higher stress values compared to PIV measurements. The bottom pictures in Figure
6.11 compare the mean pressure gradient in axial direction using

∂p̄

∂xi
= −ρ̄ūj

∂ui
∂xj
− ρ̄

∂u′iu
′
j

∂xj
− u′iu′j

∂ρ̄

∂xj
(6.6)

as done by van Gent, van Oudheusden and Schrijer (2018). For incompressible flow the last term drops out
and the field can be computed with central differencing using the Reynolds decomposition to determine
the stress terms. Both results are different. It is recommended to redo the analysis using a first order
accurate scheme at the boundary van Dijk and Krabben (2018). This is required as the resolution of the
PIV-field is poor.
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6.6 Conclusions

In the previous study flow characteristics in turbulent pipe flow including an orifice have been studied.
Integral values of the mean pressure and the mean force are studied as well as the fluctuations of these.
Additionally, velocity, pressure and force spectra are studied and compared with experiments, DNS and
literature. Finally, flow fields are visualized to interpret the flow behavior. Based on the results that have
been shown in this chapter the following conclusions are drawn

• The proposed recycling plane method is found suitable to generate turbulence at the inlet of a straight
pipe including an orifice. It is therefore expected that it can be implemented for different geometries
as well.

• Based on the region upstream of the orifice, the resolved one-dimensional energy spectra are con-
cluded to be very dependent on the applied cell size. LES 8 is concluded to resolve straight pipe
flow properly. In the orifice, the energy spectra are showing peaks at different frequencies for the
different computational grids. It is concluded that the behavior cannot be directly contributed to
one phenomenon and therefore might be physical or nonphysical. This requires additional research.
If nonphysical, this might be due to the applied extruded part, the grid resolution, or orifice meshing.
This peak content at high frequencies is concluded to have no significant effect on the flow beha-
vior. Further, it is supposed that the turbulent structures in this region are better resolved for finer
computational grids in line with the results found upstream of the orifice.

• The pressure drop is simulated properly for almost all LES based on values found in literature. The
wall pressure fluctuations in the jet-wake region by LES are concluded to be slightly overpredicted
comparing with experiments. The momentum balance is seen to be conserved based on the pressure
drop fluctuations and orifice plate force fluctuations.

• In the jet-wake region the slopes of pressure spectra compare well with theoretical and experimental
values. This is especially true for LES 8. Close to the orifice, the pressure spectra show a peak
similarly as found in the energy spectra. This requires further research.

• The force spectrum is concluded to dominate the pressure spectra upstream of the orifice. Therefore
the same conclusions are drawn as for the pressure spectra around the orifice. When neglecting the
peak, the decay of the force spectrum shows a good match with a scaling law found in literature.
Therefore, LES on grid 8 is assumed to give an accurate representation of the force spectrum by an
orifice in bounded turbulent flow.

• Additionally, LES 8 meets the accuracy criteria and shows similar flow fields compared with PIV
measurements. Therefore, the finest grid applied is found suitable to represent flow behavior on
using LES.

• Analyzing time varying velocity field, the vortex rings are shed at a frequency of roughly 1000 Hz
which corresponds to St ≈ 0.37 based on the hole velocity and orifice thickness.
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Chapter 7

Conclusions & Recommendations

This work basically consists of two parts to answer the proposed research questions. First literature is
reviewed. Later on practical LES are performed to achieve the goal of this thesis. This goal is to determine
the source term that disturbs bounded pipe flow.

7.1 Conclusions

From the literature review it is concluded that a couple of mechanisms contribute to the generation of
acoustic noise. These are stretching vortices relative to the body, the separation of flow from the pipe wall,
the shedding of vortex rings and the action of turbulence. From the sound generating sources, only the
dipole term is found important. A monopole term only arises from bad pump behavior and mass injection
or leakage, which is not the case. Quadrupole noise represents the noise generated by fluid shear stresses.
This noise source is, however, only significant for Mach numbers in the neighbourhood of one or above.
Mach number considered in this thesis are lower. Therefore, the only source term present in the current
problem are dipoles which represent a fluctuating reaction force of a body to the fluid. From a review
of literature it is concluded that this term cannot be measured easily. It is tried to determine the source
term based on an analytical coupling with pressure measurements. This analytical solution estimates that
large force fluctuations are required to generate noise elsewhere. These values are overestimated because
free-field noise propagation was considered. Therefore performing incompressible Large Eddy Simulations
is suggested.

LES results of straight pipe flow have shown that a recycling plane method is easiest and best to generate
turbulence at the inlet of the domain. No accurate initial information is required and results have shown
that the length to reach real turbulent pipe flow are shorter using this method. Therefore the domain
length can be decreased. This decreases the simulation time which is beneficial. Only a domain extension
of three pipe diameters is found sufficient to apply this method. Additionally, based on the results this
method is concluded to be applicable to all kinds of geometries. With the design choices discussed in this
work a LES setup is thus suggested which is suitable to study pipe flow.

Simulation results of turbulent pipe flow disturbed by an orifice agree can also be studied using this setup.
Velocity and pressure results of LES are in accordance with literature, experiments and DNS. In the grid
refinement study all results converged to the reference values. Therefore the LES on the finest grid is found
to perform best. The captured source term is seen to be accurately simulated with LES on the finest grid
showing a power spectral density shape equal to literature. The corresponding grid sizes are close to the
Taylor microscales and therefore this is concluded to be a good length scale to base the grid size on. With
this the proposed setup is found suitable to study the characteristics of the sound source. Simulations are
performed within a week. So from this work it is concluded that the source term disturbing bounded flow
can be determined with an acceptable accuracy using practical Large Eddy Simulations.
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CHAPTER 7. CONCLUSIONS & RECOMMENDATIONS

7.2 Recommendations

Based on the performed work a couple of recommendations are done. First of all the work achieved
on the analytical solution of the source term has to be extended including proper boundary conditions.
Afterwards, a predicted force spectrum based on measured acoustic pressure spectra should be compared
with force spectra obtained with the performed LES.

Secondly, it is recommended to investigate the origin of content peaks in velocity, pressure and force spectra.
The computational grid around the orifice has to be reviewed and a with that a possible link between the
proposed grids and peak-frequencies should be investigated. To do so additional LES can be executed
on very coarse grids. In that setup, the extruded part has to contain the same cell structures as in the
domain of interest. If the peak behavior is nonphysical, this should give the required information. Physical
peak behavior should be studied performing LES for different flow speeds and geometry dimensions. For
this purpose the different flow structures should be studied simultaneously. The obtained data can be
directly used to come up with a scaling law to determine the source term. When performing the LES, it
is suggested to decrease the length of the computational domain upstream of the orifice to speed up the
LES.

Last, the source term can be determined from velocity and vorticity fields. A complete description of
this is given by Rienstra and Hirschberg (2001). It is recommended to compare the force spectra by this
method with the force spectra given in this thesis.
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Appendix A

Coupling with Theory

In this appendix, Curle’s analogy in integral form is worked out, given in Equation 2.38. First, the route
to this expression is given, explaining why an additional source term is present in the vicinity of solid
bodies (Curle (1955)). Additionally, assumptions and conditions are listed. In order to do so, the non
homogeneous wave equation, or Lighthill’s equation, see Chapter 2.6.1, is started with

∂2ρ

∂t2
− c20

∂2ρ

∂xi∂xi
=

∂2Tij
∂xi∂xj

(A.1)

Green’s function, G(x, t|y, τ), can be used to solve differential equations of the form

Lu(x) = f(x) (A.2)

In here, L is an differential operator. A property of Green’s function is that it satisfies

LG(x, s) = δ(s− x) (A.3)

Assuming that Green’s function also satisfies the wave equation, results in

∂2G

∂τ2
− c20

∂2G

∂y2i
= δ(x− y)δ(t− τ) (A.4)

τ is the source time and x − y is the distance between source and observer. Now Lighthill’s equation is
rewritten such that ρ′c20 appears everywhere. As done obtaining the wave equation, multiplying Lighthill’s
equation with Green’s function and multiplying Equation A.4 with ρ′c20 results in both(

1

c20

∂2(ρ′c20)

∂τ2
− ∂2(ρ′c20)

∂y2i
=

∂2Tij
∂yi∂yj

)
·G (A.5)(

1

c20

∂2G

∂τ2
− ∂2G

∂y2i
= δ(x− y)δ(t− τ)

)
· ρ′c20 (A.6)

Subtracting the first from the second results in

δ(x− y)δ(t− τ)ρ′c20 −
∂2Tij(y, τ)

∂yi∂yj
G =

1

c20

(
ρ′c20

∂2G

∂τ2
−G∂

2(ρ′c20)

∂τ2

)
−
(
ρ′c20

∂2G

∂y2i
−G∂

2(ρ′c20)

∂y2i

)
(A.7)

Note that the fluctuations of pressure (or density) are now regarded. Now this expression can be integrated
with respect to y over volume V and with respect to τ between t = −T and t = T . After rewriting, the
density field for a observer at a certain time is given as

ρ′(x, t)c20 =

∫ T

−T

∫∫∫
V

∂2Tij(y, τ)

∂yi∂yj
Gd3ydτ +

∫ T

−T

∫∫∫
V

1

c20

[
ρ(y, τ)′c20

∂G2

∂τ2
−G∂

2(ρ(y, τ)′c20)

∂τ2

]
d3ydτ

−
∫ T

−T

∫∫∫
V

[
ρ(y, τ)′c20

∂2G

∂y2i
−G∂

2(ρ(y, τ)′c20)

∂y2i

]
d3ydτ

(A.8)

67



APPENDIX A. COUPLING WITH THEORY

Note that integrating the Dirac delta function, δ, over a distance equals one. Using Gauss’s divergence
theorem results in

ρ′(x, t)c20 =

∫ T

−T

∫∫∫
V

∂2Tij(y, τ)

∂yi∂yj
Gd3ydτ +

∫ T

−T
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ρ(y, τ)′c20

∂2G

∂y2i
−G∂
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∂y2i

]
nid

2ydτ

−
[∫∫∫

V

1

c20

[
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∂G2

∂τ2
−G∂

2(ρ(y, τ)′c20)

∂τ2

]
d3y

]
τ=−T

(A.9)

According to (Rienstra and Hirschberg (2001)) the initial condition term drops out if T is large enough.
This results in a volume and surface integral. The volumetric source is rewritten using Gauss’s divergence
theorem and following Curle’s Doak approach (Santana (2019)). The volumetric term is rewritten to∫ T

−T

∫∫∫
V

∂2Tij(y, τ)

∂yi∂yj
Gdydτ =

∫ T

−T

∫∫∫
V

Tij
∂2G
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d3ydτ (A.10)

+

∫ T

−T

∫∫
∂V

[
Tij(y, τ)

∂G

∂yi
−G∂Tij(y, τ)

∂yi

]
nid

2ydτ

Substituting Equation A.10 into Equation A.9 and grouping terms gives

ρ′(x, t)c20 =

∫ T

−T

∫∫
∂V

[(
ρ(y, τ)′c20δij + Tij

) ∂G
∂yi
−G

∂
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)
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V
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(A.11)

Implementation of the Lighthill stress tensor, see Equation 2.30, into the surface integral leads to

ρ′(x, t)c20 =

∫ T

−T

∫∫
∂V

[
(ρuiuj + σij)

∂G

∂yi
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(A.12)

Now
∂

∂yj
(ρuiuj + σij)nj = − ∂

∂τ
(ρui) (A.13)

Due to the reciprocity theorem

∂G0

∂yi
= −∂G0

∂xi
,

∂2G0

∂yi∂yj
=

∂G0

∂xi∂xj
(A.14)

Equation A.12 is rewritten to the form

ρ′(x, t)c20 = − ∂

∂xi

∫ T

−T

∫∫
∂V

(ρuiuj + σij)G0njd
2ydτ +

∫ T

−T

∫∫
∂V

∂ (ρuj)

∂τ
G0njd

2ydτ

+
∂2
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∫ T

−T
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V

Tij(y, τ)G0d
3ydτ

(A.15)

In here the free-field Green’s function is defined as

G0(x, t|y, τ) =
δ(t− |x− y|/c0 − τ)

4π|x− y|
(A.16)

The contribution of the monopole, dipole and quadrupole are already recognized in Equation A.15. If each
surface is fixed or vibrating in its own plane and additionally impermeable, then

uini ≡ 0 (A.17)
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This means that the second surface integral in Equation A.15 drops out. In other words, if there is no
mass injection, the surface integral representing the monopole drops out. Obviously only at the time the
sources are active, the source terms contribute to the density field. The source time is defined as the
observer time minus the time a wave needs to travel from the source to the observer

τ = t− |x− y|/c0 (A.18)

Applying this to Green’s function, it returns only one if the difference between the source time and the
recalculated source time from the observer its perspective is zero. Evaluating the integral therefore leads
to the density field

ρ′(x, t)c20 = − ∂

∂xi

∫∫
∂V

[ρuiuj + σij ]τ
njd

2y

4π|x− y|
+

∂2

∂xi∂xj

∫∫∫
V

[Tij(y, τ)]τ
d3y

4π|x− y|
(A.19)

Equation A.19 is the fundamental result of Curle as already given in Chapter 2.7. However, as mentioned,
this expression is not very useful in this form. As described in Chapter 2.6.3, quadrupoles are playing a
minor role in specific cases. Continuing with the exact expression assuming quadrupoles can be neglected
leads to

ρ′(x, t)c20 = − ∂

∂xi

∫∫
∂V

[ρuiuj + σij ]τ
njd

2y

4π|x− y|
(A.20)

Applying the next chain rule
∂F (τ)

∂xi
=

∂τ

∂xi

[
∂F (τ)

∂τ

]
τ

(A.21)

In this expression, ∂τ/∂xi can be defined as

∂τ

∂xi
= − (xi − yi)
|x− y|c0

= −cos(θ)

c0
(A.22)

Those terms are typical for dipole sound behavior. Applying the chain rule to Equation A.20 results
in

ρ′(x, t)c20 =

∫∫
∂V

[
ρuiuj + σij

∂τ
+

(ρuiuj + pij)c0
|x− y|

]
τ

nj cos(θ)d2y

4π|x− y|c0
(A.23)

Assuming low speeds, the momentum terms drop out. Additionally the net force applied by the surface
to the fluid is

Fi(τ) =

∫∫
∂V

σijnjd
2y (A.24)

Therefore the final approximation to Curle’s exact analogy reads

ρ′(x, t)c20 =

[
∂Fi(τ)

∂τ
+
Fi(τ)c0
|x− y|

]
τ

cos(θ)

4π|x− y|c0
(A.25)

This expression is not found often in literature, see for example (Atassi (2020)). Most of time the second
term between brackets is not included as this term becomes less important for large distances between
source and observer (x− y).

A.1 Discretization

Equation A.25 provides a coupling between of the fluctuation part of the pressure and the fluctuating force
in time. In order to calculate the one signal from the other, this expression has to be discretized. Using
one sided difference this derivative can be expressed. As the force is mainly pointing perpendicular to the
orifice plate, which is in flow direction, i = 1. Index j is introduced for indexing the signal. The direction
interested in is cos(θ) = 1, see Figure 2.5b. This results in

ρ′(x, t)c20 =

[
∂Fi(τ)

∂τ
+
Fi(τ)c0

r

]
τ

1

4πrc0
(A.26)
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Rewriting results in

p′ =

[
1

rc0

∂Fi(τ)

∂τ
+
Fi(τ)

r2

]
1

4π
(A.27)

Using one sided differencing to discretize the derivative results in

p′j =

[
1

rc0

F (tj − r/c0)− F (tj−1 − r/c0)

∆t
+
F (tj − r/c0)

r2

]
1

4π
(A.28)

Regrouping results in

p′j4π = F (tj − r/c0)

(
1

rc0∆t
+

1

r2

)
− F (tj−1 − r/c0)

1

rc0∆t
(A.29)

Rewriting results in

F (tj − r/c0) =

(
p′j4π + F (tj−1 − r/c0)

1

rc0∆t

)
/

(
1

rc0∆t
+

1

r2

)
(A.30)

The solution can be initialized using a moderate value for the force.
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Appendix B

Simulation Setup Steps
STAR-CCM+

In this appendix a general full simulation setup procedure is enumerated to re-do RANS simulations and/or
LES performed in this thesis.

B.1 Geometry/Continuum/Region

1. Open new file.

2. Create a new 3D-CAD model under Geometry > 3D-CAD Models. Sketch the region of interest.
Rename the surfaces to inlet, outlet, pipe wall etc. Update and close the 3D-CAD model.

3. Right click the created 3D-CAD model and click New Geometry Part and continue using default
settings. Rename this created part to Fluid Part under Parts.

4. Then assign this part to a region by right-clicking the created part. Select Create a Boundary
for Each Part Surface and continue. Rename the region to Fluid Region under Regions. Change
the boundary types in the region. The inlet is typically a velocity inlet and the outlet is a pressure
outlet. The pipe wall is just a wall already by default.

5. The region needs a physics continuum. Under Continua create a new physics continuum. Rename
to either LES or RANS continuum depending on the simulation technique to be used. If both
techniques will be used, for example using RANS to initialize LES, then just create two continua.
Depending on the technique, select the following models in this continuum: Three Dimensional,
Implicit Unsteady, Liquid, Segregated Flow, Constant Density, Turbulent, Large Eddy Simulation.
Keep the automatically selected models. The automatically selected models are: Gradients, WALE
Subgrid Scale, Exact Wall Distance, and All y+ Wall Treatment.

6. In these models change the material properties of the medium under Liquid to that of water at
the temperature of interest. When intentionally central differencing is desired to be used, lower the
upwind blending factor under the Segregated Flow model. For Implicit LES, the Cw value under
the WALE Subgrid Scale model has to be lowered.

7. The region additionally needs a mesh. Create a new Automated Mesh operation under Geometry
> Operations > New > Automated Mesh. Select the part of interest and the following meshers:
Polyhedral Mesher, Surface Remesher, and Advancing Layer Mesher. Please note that sometimes
the Prism Layer Mesher is also sufficient.

8. In this automated Mesh, change the Base Size, Surface Growth Rate, Number of Prism
Layers, Prism Layer Stretching, and Prism Layer Total Thickness. If specific faces require
different values of above parameters, a new specific surface control can be created under Operations
> Automated Mesh > Custom Controls.
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9. Execute the created mesher under Mesh > Generate Volume Mesh.

10. Run a full mesh analysis under Mesh > Diagnostics. Select the region and report type full and
check the cell skewness (< 85◦) and minimum face validity (>1). Additionally, always judge the
quality of the mesh by visualizing for example the inlet/outlet creating a scene of the mesh.

B.2 Initialization/Boundary conditions

1. Change the maximal number of eddies to at least 1000000 under Continua > ”Physics Con-
tinuum” > Reference Values > Maximum Number of Eddies.

2. Specify under Continua > ”Physics Continuum” > Initial Conditions the pressure and velo-
city field using average fields of a precursor simulation. Specify turbulence by selecting Intensity +
Length Scale under Synthetic Turbulence Specification. Also specify those using average fields of a
precursor simulation. If this is not possible, give constant values. If the solution converges this is no
problem, but eliminating the initials will take more time.

3. Under Regions > ”Region” > Boundaries > ”Inlet” change the boundary conditions of the
inlet. In case of using the Synthetic Eddy Method for specifying turbulence, the method under
Synthetic Turbulence Specification has to be set to Intensity + Length Scale. Also enable
Mass Flow Scaling under Synthetic Turbulence Mass Flow Scaling Specification. Then
set the Physics Values of the Intensity, Length Scale and Velocity at the inlet by importing cross
sectional fields of a precursor simulation and provide them using tables. If the recycling plane method
will be applied, follow the steps in Appendix B.3.

B.3 Data mapping

In order to create a fully developed profile at the inlet of the geometry of investigation, fully developed
data can be mapped onto this inlet boundary plane. An extra part has to be created over which fully
developed conditions are obtained. The procedure is as follows:

1. Extend the already created part at the inlet side under Geometry > Operations > New >
Surface Preparation > Surface Extruder. Select the already existing part and inlet surface
part. Under Output Part Surfaces select Single Side. Change the Extrusion Distance and
enable both options Create Volume Extruder Operation From Output Parts and Execute
Surface Extruder Operation Upon Creation.

2. Assign the new Surface Extruder part to the already existing region. This procedure is the same as
done before, but select the setting Assign All Parts to an Existing Region in the Assign Parts
to Regions menu and select the region. Again Create a Boundary for Each Part Surface. In
the bottom drop down menu select Do Not Create Interfaces From Contracts as data will be
mapped from the one surface to the other. Then continue.

3. Under Regions > ”Region” > Boundaries set the boundary types of the extruded part to again
a velocity inlet and a pressure outlet. Also rename the surfaces.

4. Create a fully developed interface using the inlet and outlet of the extruded part selecting both
boundaries and click Create Interface.

5. Under Interfaces rename the created interface and change the type to Fully-Developed Interface.
Under Interfaces > ”Interface” > Physics Conditions > Fully Developed Flow option
select Mass Flow Rate. Set this value under Physics Values.

6. Create a new Data Mapper under Tools > Data Mappers > New Data Mapper > Surface
Data Mapper. Select the outlet of the extruded part (not interface) as Source Surface of the Sur-
face Data Mapper. Select Velocity as the vector field function. Then under Target Specifications
> ”Surface” select the inlet of the region of interest as the target entity. Then under Update
enable this data mapper and select Time Step as the trigger for it. Please note that the surfaces
of the region have to be selected instead of the part surfaces.
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7. Run the mesher again under Mesh > Generate Volume Mesh.

8. The newly created field functions, probably called MappedVertexVelocity, have to be used to assign
the physics values to the velocity inlet of the original part. To do so, change the Synthetic Turbu-
lence Specification method to None under Regions > ”Region” > Boundaries > ”Inlet” >
Physics Conditions > and change the Velocity Specification to components. Under Physics
Values now the velocity is provided by a field function selecting the vector function MappedVert-
exVelocity.

B.4 Solver

1. Under Solvers > Implicit Unsteady change the time step and the temporal discretization. Most
likely 2nd-order is chosen.

2. Under Solvers > Segregated Flow change the Under-Relaxation Factor of Velocity and Pres-
sure. Additionally, if stability allows, choose Optimized 2nd-order (5) under High-Accuracy
Temporal Discretization.

3. Under Stopping Criteria the number of inner iterations and physical time can be specified.

B.5 Derived parts/Report/Monitor

Derived parts have to be created to display or monitor results. This, however, is a matter of choice and is
therefore less strictly listed.

1. Plane sections can be created under Derived Parts > New Part > Section > Plane. Likely,
cross sectional planes are to be created at every diameter in axial direction downstream of the inlet.
Additionally, a cross section in axial direction is helpful.

2. Additionally create point probes in cross sectional direction to capture profile data. A general tip
is to open for example a mesh scene and then create new derived parts, Edit in Current Scene.
This gives additional options such as snapping the derived parts to parts. Another tip is to select
besides the region, also the surfaces of the part as input parts. If not, it might be that field values
cannot be captured by the derived parts.

3. To collect for example wall pressure data, point probes are to be created. For wall probes it is very
important to snap them to the pipe wall of the part.

4. To avoid repetitive work, Macros can be used to generate a lot of derived parts, as well as reports,
monitors and result tables. To do so, first start recording by clicking the blue dot in the toolbar.
Then create a derived part as described above. Then stop the recording and save the macro. Opening
the macro with a text editor gives the option to adjust the macro and therefore automate the creation
of for example derived parts. Apply for loops in the style of JavaScript.

5. Report can be created under Reports. To get point data, a maximum report should be created.

6. To get the data as a function of iteration or timestep, a monitor should be created from the report.
This is done by right-clicking the report and clicking Create Monitor from Report. Data can be
exported after a simulation by right-clicking the monitor and clicking Export.

7. Data of line probes can be exported using tables under Tools > Tables > New Table > XYZ
Internal Table. The right scalar and derived parts should be selected. Additionally, the Data on
Vertices option should be enabled.

8. To get the mean or variance values in time of quantities, a monitor should be created. Under
Monitor > New Monitor both a field max or field variance can be created.
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B.6 Field functions

An important step is ensuring that all data is collected for good post processing. This requires the right
field functions. A list of possibly important quantities to monitor is provided.

1. The development of mean values over simulation time are very important. It is advised to create
mean field monitors of axial velocity, pressure, and variances of the velocity components (axial,
tangential and radial).

2. With the variances of the velocity components, the turbulent kinetic energy can be computed using
Equation 2.6. A new field function can be created under Tools > Field Functions > New >
Scalar. The definition of the TKE field function is: 0.5 ∗ (${FieldV arianceV elocityiMonitor} +
${FieldV arianceV elocityjMonitor}+ ${FieldV arianceV elocitykMonitor}).

3. Tracking the development of the mean of velocity, pressure and TKE, the time to eliminate initial
effects (1st and 2nd order effects) can be determined. From this point on the real sampling of mean
and variance values can start. The next mean quantities are of interest: CFL number, pressure, SGS
TKE (see next bullet point), skin friction coefficient, TLS, turbulent viscosity, turbulent viscosity
ratio, axial velocity, radial velocity, tangential velocity, vorticity, wall shear stress, and wall Y+.
Field variances of the next quantities are of interest: axial velocity, radial velocity, tangential velocity,
pressure, and wall shear stress.

4. To enable the SGS Turbulent Kinetic Energy field function StevePortal (2019d), the Ffowcs Williams-
Hawkings model has to be activated along with the subgrid scale model.

B.7 Other

1. Shorten the name of the reports and monitors created as these end up in the saved file.

B.7.1 How to determine average cell size in bulk region

1. Create a field function defined as in Equation 4.22, with definition: 1.2 ∗ pow($V olume, 1/3).

2. Create a threshold derived part under Derived Parts > New Part > Threshold.

3. As only the cell size of the bulk region is of interest now, it is very important to create a mesh with
prism layer cells being larger than the estimated bulk cell base size, so these cells can be excluded
when determining the average cell size.

4. Select the region as part in the new derived part. Select the created field function as Scalar Field.
Set the range from zero to a little less than the cell size of the prism layer. Only then the prism layer
is excluded. To check and ensure, a scene can be created checking the grid size.

5. Run a volume average report for the created field function and new derived part.

6. The result gives a good estimate of the average cell size in the bulk region.
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Appendix C

Reynolds-Averaged Navier-Stokes

A way to compute the motion of fluid is using the Reynolds-averaged Navier-Stokes (RANS) equations.
The behavior of turbulent flows can be computed in a computational friendly way, averaging the fluctu-
ating quantities of motion in time. RANS simulations give a reasonable insight in the mean behavior of
the flow and provides proper input for the non-time-averaged computational methods as LES. RANS is
computationally interesting because of removing all scales of motion (u′i = 0). In time-averaged form, the
governing equations of motion of a stationary and incompressible Newtonian fluid are

ρūj
∂ūi
∂xj

=
∂

∂xj

[
−p̄δij + µ

(
∂ūi
∂xj

+
∂ūj
∂xi

)
− ρu′iu′j

]
+ ρf̄i (C.1)

Equation C.1 consists of the same terms as in the momentum equations, see Equation 2.2, without time
dependent terms and with an additional term ρu′iu

′
j . This additional term is called the Reynolds stresses

arising from taking the mean from the nonlinear convective term. Time-averaging the conservation equa-
tion, Equation 2.1, together with the Reynolds-averaged momentum equations, provides four independent
equations to solve the unknowns. Besides the pressure component and three velocity components, however,
the additional Reynolds stresses are unknown quantities as well. Having more unknown than equations
introduces the closure problem. A determination of the Reynolds stresses is required to close the problem
and solve for the unknown quantities ui and p.

C.1 Precursor steady-state simulation

A precursor steady-state simulation is intended to provide a good initial averaged solution to the transient
simulation. A precursor simulation solution close to the actual converged unsteady solution shortens
the time spent in the initial stage of the transient run adjusting the unsteady flow to its mean state.
Additionally, running a precursor steady-state simulation on an exploratory mesh provides information for
the required grid size and time step for the LES (Tucker (2016)).

C.2 Closure problem

By introducing turbulence models, the closure problem can be tackled. The turbulence model used to
do so is the turbulent viscosity hypothesis. This hypothesis, proposed by Boussinesq, determines the
Reynolds-stress by the mean velocity gradients. It is given as

u′iu
′
j =

2

3
kδij − 2νT S̄ij (C.2)

In here, νT is the turbulence eddy viscosity, Sij is the mean rate-of-strain tensor

S̄ij =
1

2

(
∂ūi
∂xj

+
∂ūj
∂xi

)
(C.3)
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, and k is the turbulence kinetic energy defined as k = 1
2u
′
iu
′
i. The turbulent viscosity can be written

as a product of a velocity U∗ and length l∗. A widely technique to specify the turbulent viscosity in
CFD models, is the k-ε model proposed by Launder and Spalding Launder and Spalding (1983). This two
equation model uses a turbulent viscosity νT = ρCµk

2/ε. In here ε is the turbulence dissipation, and Cµ
is a flow dependent parameter. Note that in RANS the to be closed term is not a function of length scales
and thus numerical grid, as in LES, but only on variables k and ε in case of using the k-ε method.

C.3 Turbulence models

Often applied turbulence models are the k-ε and k-ω model. Both are two equation models to solve the
variables of the model to determine the turbulent eddy viscosity. Applying the former is best in the
form of the Realizable k-ε form being better than the Standard k-ε for many applications (STAR-CCM+,
2018, p. 6990). This model is applied in combination with the Two-Layer together with the All y+ Wall
Treatment.

The k-ω model is beneficial over the k-ε model in regions with an adverse pressure gradient, existing
in the orifice region. However, its disadvantage is its huge dependency on inlet conditions for internal
flows (STAR-CCM+, 2018, p. 7019). The k-ω model is combined with the SST blending both the prac-
ticalities of k-ω and k-ε.

C.3.1 Exploratory meshes

Precursor RANS is performed on exploratory meshes. Flow is modelled using prism layers near the wall
and polyhedral cells in the bulk region, see Section 4.4. Three meshes are proposed consisting of either
ten, twenty, or thirty prism layers in combination with a cell base size of respectively 0.7mm, 0.4mm, and
0.2mm. The exploratory numerical grids are build up with respectively 207k, 1208k, and 7488k cells. Cross
sections of the coarse (207399 cells), finer (1208931 cells) and finest mesh (7488721 cells) are depicted in
Figure C.1.

(a) (b) (c)

Figure C.1: Computational meshes used for getting the RANS results. a: Coarse mesh; 10 prism layer
cells and a cell base size of 0.7 mm. b: Finer mesh; 20 prism layer cells and a cell base size of 0.4 mm. c:
Finest mesh; 30 prism layer cells and a cell base size of 0.2 mm.

C.3.2 Boundary conditions

The turbulence intensity and turbulence length scale are used to specify turbulence for initialization and
inlet turbulence creation for the RANS simulation. These should be in the right range in order to have
reasonable answers far from the inlet. Russo and Basse (2016) provided a turbulence intensity scaling
as

I ≡ u′

Ub
= 0.140Re−0.0790 (C.4)
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The turbulent length scale is estimated as (STAR-CCM+, 2018, p. 3682):

l = 0.05D (C.5)

A plug velocity of U = Ub = 1.06m/s is used based on the mass flow rate. After convergence, cross
sectional data far from the inlet is captured and applied for inlet conditions. With that fully developed
turbulence is obtained in the whole region. These fields are assumed suitable for initializing LES. It is
important to note that a field function has to be created specifying the turbulence length scale, using e.g.
the Realizable k-ε turbulence model, as:

l = Cµ
k

3
2

ε
. (C.6)

C.4 Precursor RANS results

Modeling turbulence using the k-ε and k-ω model, a fully developed velocity and TKE profile are simulated,
as illustrated in Figure C.2, for all exploratory meshes. Comparing to DNS data, obviously both turbulence
models give better solutions of turbulent profiles for finer meshes. In Figure C.2a namely, the viscous
sublayer is more accurately simulated as well as velocity values starting at the log-law region (y+ > 30).
Also in Figure C.2b this also the case showing values closer to the well resolved solution. TKE peak values
are located at the right location, showing significantly lower values, especially using the k-ω model. Note
that because of understanding reasons, the TKE is intentionally plotted with normal x-scale. Subsequently,
on the x-axis the distance from the wall is normalized with diameter because the distance to the wall y+
shows large deviations for different Reynolds numbers when not on a log-scale. RANS simulations are
known to show this behavior, indicating that resolving on an even finer grid is not required. For this
particular case the k-ε model is found to give most accurate results.
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Figure C.2: Fully developed turbulent profiles obtained with RANS using the k-ε and k-ω model for two
exploratory meshes. a: Normalized axial velocity component. b: Normalized TKE.

Important length scales obtained with the k-ε on the finest grid are illustrated in Figure C.3. These
length scales are elaborated on in Section 2.3. For LES of orifice flow, two regions are of interest for
scale resolving; the region upstream and downstream of the orifice. The with that associated Taylor-micro
scales are found relatively independent on the RANS model and mesh used adopting values from 0.5mm
to 0.8mm upstream of the orifice. Lower values of the scale at which energy dissipation starts are found in
the jet region, indicating that smaller cell sizes are required to resolve scales in that region. For reasonable
LES therefore the cell sizes should be in the nearby of 0.1mm in that region, see Figure C.3b.

The turbulent length scale, which is more sensitive to changes in the modeled turbulent kinetic energy and
turbulent dissipation rate, is more mesh and model dependent, see Figure C.3. As in the very center of
the pipe the TKE is not well modeled, the obtained TLS is likely to be off. This important scale is to be
tested in LES.
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Figure C.3: Fully developed turbulent scales obtained with RANS using the k-ε and k-ω model for different
meshes. a: TLS, TMS, and KLS at z/D = −2 (fully developed pipe flow) and z/D = 2 (recirculation
zone) from orifice. b: Turbulent length scale at z/D = −2 (fully developed pipe flow) and z/D = 2
(recirculation zone) from orifice.

Besides resolving length scales, representing time scales is important. In LES the eddy-turnover time of
large t is namely proportional to the time step chosen. If a time step larger than t is chosen, flow mixing
of larger scales is limited. Therefore, the time step chosen imposes a limit to the development of smaller
scales. Choosing a time step, the turbulent time scale can be considered in LES (STAR-CCM+, 2018,
p. 2896). In the RANS simulation on the finest mesh the smallest turbulent time scale of the dissipative
eddies, tη, is found in the jet region being 5× 10−6 s. For the turbulent time scale this is roughly 1× 10−4

s.

In simple pipe flow the pressure drop can be related to the average wall shear stress by

∆pAp = τwAw (C.7)

Wall shear stress values are typically around 4.44 Pa which is in accordance with the measurements of den
Toonder and Nieuwstadt Den Toonder and Nieuwstadt (1997). A pressure drop of 0.209 bar is found for
the k-ε on finest grid.
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Computational Grids for LES

(a) Grid 1. (b) Grid 1.

(c) Grid 2. (d) Grid 2.
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(e) Grid 3. (f) Grid 3.

(g) Grid 4. (h) Grid 4.

(i) Grid 5. (j) Grid 5.
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(k) Grid 6. (l) Grid 6.

(m) Grid 7. (n) Grid 7.
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(o) Grid 8. (p) Grid 8.

Figure D.1: Used computational meshes with settings tabulated in Table 4.1. a: Cross section of Grid 1
(cell base size is 0.7mm, 10 prism layer cells). b: Orifice region of Grid 1 (cell base size is 0.7mm, 10 prism
layer cells). c: Cross section of Grid 2 (cell base size is 0.5mm, 12 prism layer cells). d: Orifice region of
Grid 2 (cell base size is 0.5mm, 12 prism layer cells). e: Cross section of Grid 3 (cell base size is 0.5mm,
25 prism layer cells). f: Orifice region of Grid 3 (cell base size is 0.5mm, 25 prism layer cells). g: Cross
section of Grid 4 (cell base size is 0.35mm, 25 prism layer cells). h: Orifice region of Grid 4 (cell base size
is 0.35mm, 25 prism layer cells). i: Cross section of Grid 5 (cell base size is 0.35mm, 5 prism layer cells).
j: Orifice region of Grid 5 (cell base size is 0.35mm, 5 prism layer cells). k: Cross section of Grid 6 (cell
base size is 0.35mm, 12 prism layer cells). l: Orifice region of Grid 6 (cell base size is 0.35mm, 12 prism
layer cells). m: Cross section of Grid 7 (cell base size is 0.35mm, 8 prism layer cells). n: Orifice region of
Grid 7 (cell base size is 0.35mm, 8 prism layer cells). o: Cross section of Grid 8 (cell base size is 0.2mm,
10 prism layer cells). p: Orifice region of Grid 8 (cell base size is 0.2mm, 10 prism layer cells).
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Results of Straight Pipe
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Figure E.1: The development of quantities as a function of the upstream distance to the inlet. a: The wall
shear stress. b: The bulk TKE normalized with the bulk velocity squared.
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Figure E.2: Development of quantities as a function of the upstream distance to the inlet. a: Bulk velocity.
b: Centerline axial velocity component normalized with the bulk velocity.
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Figure E.3: Development of the TKE as a function of the upstream distance to the inlet. a: Bulk TKE
normalized with the bulk velocity squared. b: Maximal TKE normalized with the bulk velocity squared.
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Figure E.4: Wall shear stress as a function of the computational grid properties. a: As a function of the
cell size in bulk region. b: As a function of the cell size of last prism layer. c: As a function of fraction
of the cell size of the layer prism layer and the cell size in bulk region. d: As a function of the stretching
factor.
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